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Niagara Enterprise Security Facility Manager's Guide About this guide

About this guide

This guide is for the facility manager who is responsible for setting up operating procedures, managing
tenants, and configuring options.

This document is part of the Niagara Enterprise Security technical documentation library. Released versions of
software include a complete collection of technical information that is provided in both online help and PDF
formats.

Document change log
The following list describes significant documentation changes.

March 17, 2025

¢ Updated the "Getting Started" chapter to include the "NAC Controller Setup Menu" and related topics
on NAC controllers.

e Removed Assure ID references.

April 11, 2023

Updated “Visitor management with Sine” chapter.

August 4, 2022
Added “Visitor management with sine” section in People Management chapter.

January 24, 2020
Minor changes to topics in the preface.

August 8, 2019
Reorganized document and added updates related to Niagara 4.8 release.

October 9, 2018
Minor editorial updates.

September 17, 2018

Initial release for version 2.4

Related documentation
These documents provide additional system information.

* Niagara Enterprise Security Installation and Maintenance Guide
* Niagara Enterprise Security Reference
* Niagara Enterprise Security Operator's Guide
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Chapter 1. Getting Started

This system is a comprehensive building access control solution, built on an open, IP-based platform.
System architecture provides the following:

* LAN or WAN connection using standard TCP/IP communications
* A browser interface with multiple-user access

* Support for a network of controllers whose relationships can be configured, with a single Supervisor, and
the possibility for multiple peer and subordinate relationships in a hierarchy

* A network of door control modules and remote input/output modules
* Global access control functions for all devices connected on the local and network controllers
* Intrusion zones and access zones that span multiple controllers

* Global administration of access control and monitoring functions for all devices connected to the
controllers

¢ An embedded database to store credential information, as well as event and alarm transactions

This system runs on a Java virtual machine (JVM) that supports application programs running on any platform
without a program having to be rewritten or recompiled for each separate platform.

Logging in to the system

To use this system you need to connect to the station using a browser and log in using valid credentials.
Prerequisites:

Get the network address of the station that you want to log in to from your system administrator. This may be
an IP address or a URL depending on how your station is configured and how, or if, it is routed to the Internet.

Step 1. From a computer that is on the system network, open a browser.

Step 2. Inthe browser address bar, type the IP (Internet Protocol) address of the computer (Supervisor
PC) or remote controller, for example, https://192.168.1.123/login
The login window opens. If you are logging in to the system for the first time, the default
Username is “admin” and the Password can be left blank. To ensure security, change these
settings immediately on initial setup.

Step 3. Enter your Username and Password and click Login.
You are logged in to the system and the interface opens.

Changing passwords

You should change each password, especially the admin password, on a regular basis. The security of your
system depends upon your vigilance. This procedure documents a task performed in both the Supervisor PC
and remote controller stations using the system’s browser interface. The alternative Supervisor station
command is in parenthesis.

Prerequisites:
You are logged in to the station with admin privileges.

Step 1. Navigate to Controller Setup (System Setup) > User Management > Change Password.
The Users view opens.

Step 2. Inthe Current Password property, type the current password.
Step 3. Inthe New Password property, type a new strong password.

Step 4. To confirm that you typed the name correctly, type the new password again in the Confirm New
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Password property, and click Save.
If the two values match, the system implements the change.

Step 5. To return to the home view, click Home.

Logging out of the system

Always log out and close the system interface when you are finished. Failure to log out and close the browser
window could result in unauthorized use of your account.

Step 1. In the system title bar, click the Logout button.
The system logs you out.

Step 2. To close the browser, click File > Exit.
The browser closes.

Browser controls

The user interface runs in a standard browser and has standard browser controls in addition to the custom
window controls.

Figure 1. Browser and display controls

e |:1;- https://172.31.66.10/crd?station: O ~ @ Cerl'rﬁcatee...c| & Workspace: E5... & Folder - Graphic A2 ConsoleRec... 4 Login 1 y

x @Corwerl - [GHSelect
TRIDIUM R R P 2K g
¢’ \/< \/< (@ Help 2 Logout
== Monitoring & Personnel Reports ﬁ? Controller Setup & Threat Levels m | a glgmrwé
=] Alarm Console = . Activity Monitor i Video Monitoring
& & Hl& @ a2« 8280
Time Range o ?to? 10 Source(s) / 2939 Alarm(s)
Info Timestamp Source Message Text Source State Priority Ack State
M 8 14-Sep-18 4:29:20 PM EDT Access Network Remote Reader Modulel Ping Success Normal 250 0 Acked / p
| a E 15-Sep-18 12:32:00 PM EDT AXIS 210A - 00408C836221 MotionDetectedl Normal 150 0 Acked /
O ‘E 15-5ep-18 12:32:00 PM EDT AXIS 2104 - 00408C836221 Motion Detected Normal 150 0 Acked /
O & 14-Sep-18 4:29:11 PM EDT Remote Reader Modulel.Reader 1 Badge Does Not Exist Alert 150 0 Acked /
0 & 14-Sep-18 4:29:05 PM EDT Remote Reader Modulel.Reader 2 No Access Right Alert 150 0 Acked /
O 4 14-Sep-18 3:52:37 PM EDT Remote Reader Modulel.Reader 1 No Access Right Alert 150 0 Artend f
0o & 14-Sep-18 3:52:30 PM EDT Remote Reader Modulel.Reader 2 Badge Does Not Exist Alert 150 0 W N
< >
& Acknowledge ‘ ‘ > Hyperlink ‘ ‘ ] Notes ‘ ‘ & silence ‘ ‘ < Filter ‘ ‘ £ Show Recurring ‘ ‘ H show video ‘
2

1. The browser window and controls provide standard web browser features, such as the status bar in the
lower left corner of the browser.

2. Scroll bars appear in window areas when portions of content are not visible. They may be along the right or
bottom portions of a window and browser area.
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3. Border controls allow you to drag any outside border to adjust the entire window. Drag the border between
the separate panes of some view areas to change their relative sizes.
User interface

When you log in, the user interface screen displays with the main menu across the top of the screen.

Figure 2. Example user interface

TRIDIUM X X

1 Guide = 3 4| 5| = 'Security80]
2 () Help 2 Logou

Nic

£ User Management A= Backups | #f Remote Devices #¥ Access Setup &% Intrusion

Home

E Schedules

&g Monitoring ﬁ Personnel #¥% Controller Setup @; Threat Levels

= save || & Manage Devices || [} Access Network 3

Base Reader Module Doors Elevators Additional Points  Burglar Panels  Unlock Inputs 4

Status |-[fau|t} M

Alarm Class|Medium v| | Bl Video Setup

Enabled 2

< >

Title bar
Menu bar
Links
Tabs

5. View area

P wbdh -~

Title bar

This title bar area along the top part of the interface contains controls and indicators that are visible and
available throughout the system:

¢ The station and system names are in the top right corner.
¢ Indicators and links are below the names.
® The Help and Logout links are always visible.

Menu bar

This bar is directly below the title bar. It contains two rows of menus that are visible by default. Some menu
items, when selected, display another sub-menu view.

Menus may display different selection options depending on the user log-in type and whether or not the menu
has been customized. You can customize menus to add links to new graphic views that you create.
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View pane

This (largest) area of the interface extends across the lower portion of the system of the screen and displays
the currently-selected view. Most views have a view title in the top left corner, control buttons and links below
the control buttons. often information is grouped under appropriately-titled tabs.

Title bar controls

The indicators and links available under the station and system names are:

* & The Alarm console link opens the alarm console in the view area. The alarm icon’s color reports the
current alarm state. The icon flashes red when an alarm indicates a fault or offnormal state.

* # The Job Service link displays when a job has a start time of less than one hour. Clicking this icon opens
the Job Service view. To open the Job Service view when no link is available, click System (Controller) Setup
> Miscellaneous > Jobs from the main menu.

o (B The Tenant Filter link opens the Tenant Filter window. You use this window to limit the information
displayed to only data that belongs to the tenant or tenants assigned to the current user.

e [7]The Pop Out in New Window opens the current window in a new, full-page window.

e () Help The Help button opens a page context-sensitive help related to the current view. If no context-
sensitive help is available, the complete Help Table of Contents open.

e £ Logout The Logout button logs out of the system.

NOTE: Always log out and close the browser when you are finished with a session.

Menu bar
The menu bar is located directly below the title bar and contains two rows of menus that are visible by default.

Figure 3. Menu bar

P T I W TGl ' Byitsm Batup Primary Menus

%% Bchedulen £ Uier Management Ps Byitem Bachupy g Remots Devican | i lAScENN SEiUp Seconda ry Menus

{2t Home

dd” Monltorng

T3 Access Zones - Menu Page
[Z Card Formats

The primary menus provides a common set of tabbed menus with secondary menu tabs beneath the primary
row. Additional options display as menu pages. You can customize menus (navigation) to add links to new
graphic views that you create.

Secondary menus provide access directly to views or to menu pages that contain additional related links.

Some menus provide tabs. More or fewer tabs may display, depending on user type log-in privileges and
navigation customization.

By default, the primary menus include the following titles:

* Home provides access to the other primary menus by displaying a main menu page and an expanding
navigation menu.
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Figure 4. Home view menu with Personnel expanded

s Monitoring
B & Personnel &3 Monitoring

& People & Personnel

i3 Badges Reports

Access Rights & System Setup

» Tenants = Photo ID

& Additional Persof ‘@ Photo ID Network
Reports @ Photo ID Viewers
@ System Setup & Threat Levels
Ay Threat Levels

* Monitoring provides access to the Alarm Console, Activity Monitor, and Video Monitoring menu items.

* Personnel provides access to people-related views, such as badge, access right, tenant, and personnel
views.

* Reports provides access to history reports (such as alarm history and attendance history) as well as
hardware reports that list types of equipment included in the system.

* Controller Setup (System Setup in a Supervisor station) provides access to a wide variety of configuration
menus that you can use to setup hardware, alarms, access and intrusion zones, and other functions.

* Threat Levels provides access to Threat Level and threat level setup views.

Tabs
The tabs segregate properties and related table views. The view pane may display one of a variety of types of
layouts, depending on the function of the view.
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Figure 5. People summary showing tabs.
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Niagara Enterprise Security Facility Manager's Guide

NOTE: You can move among tabs without losing unsaved data, however, you must click the button before

leaving the view or data is lost.

About the view pane

The View pane is the largest area of the user interface and is located below the title bar and menu bar.

Figure 6. View pane with table view

&d” Monitoring ﬁ Personnel

. Schedules & User Management f[% Backups

e

&% System Setup [EH Photo 1D

Remote Devices &% Access Setup

A
[E Axis Video Nebwork {ok}
[E Ldap Metwork Tok}
[E Obax Netwark Tok}
[ Photo ID Nebwork {ok}

true

true

true

The view pane may display one of a variety of layouts, depending on the function of the view. The following

view layouts are used most often:

e Table views display information in tabular form. You can sort, filter, rename and customize them using a
standard set of control buttons. Table views include reports, lists of people, hardware, access zones, access
rights, and many other types of information. Several table views use the learn mode to add or assign
information to the currently listed table. Many table views also have a Azuto Refresh option that, when

clicked, refreshes the table data.

NOTE: If a table requires more than 5,000 lines, a message alerts you that only the first 5,000 records are
available for viewing. To view all relevant data, filter the table so that its maximum display value does not

exceed 5,000 lines.

* Edit views display properties and option lists that you use to create and configure selected items.

14
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Figure 7. View pane with edit view

Ga” Monitoring

ﬁ Personnel

% Controller Setup

M Threat Levels

I% Backups &' Hemofe Devices & Access Setup #% Intrusion Setup &% Alamm Setup

B Schedules & User Management

& Miscellaneous

H Save ﬁ‘ Manage Devices Ll Arcess Metwork

Base Reader Module Doors Elevators  Additional Points  Burglar Panels

Status  [(f=ult}
Alarm Class[wigh | | B Video Setup

Enabled

These views usually have control buttons located directly below the view title for performing save, refresh,
or other context-appropriate actions.

Another characteristic of edit views is the presence of tabs for grouping information. Tabs allow you to
conveniently view more information in a small amount of user interface space. Switching among tabs does
not typically require a save action because you are not leaving the current page when you change tabs.

* Function views include views that perform a maintenance or communication action, such as a system
backup or a network identification action.
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Figure 8. View pane with a typical function view
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Controller (System) Setup menu

Setup features configure system components and network properties, as well as user preferences and other
variables. Setup views include a variety of interfaces that allow you to perform configuration tasks related to
devices, users, as well as the performance and maintenance of the system.

Figure 9. Controller Setup menu

Foal o ) BB - Supervisor only

ﬁPelﬁonnel D Reports #:' Controller Setup

£y Home

¥ Schedules 2 User Management [ Backups &' Remote Devices ' Access Setup  &° Intrusion Setup 5 Alarm Setup

G Monitoring

In a Supervisor system, configuration features are accessed using the System Setup menus. In a remote
controller, similar features are accessed using the Controller Setup menus. When features are the same for
both the Supervisor and controller stations, this documentation refers to them as Controller (System) Setup
features.

NAC Network Setup Menu

NAC network Setup features configure system components and network properties, along with user
preferences and others. Setup views for the NAC Network under Remote modules include various interfaces
that allow you to perform configuration tasks related to the NAC Controller, Doors, and Reader, as well as the
NAC Server's network connection property.
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Figure 10. NAC Network Device Manager view
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In a supervisor system, the NAC network view consists of actions and properties to add, discover, and
configure NAC controllers.

Add NAC Controller Manually

The NAC network view consists of an "Add" option that enables the user to configure or add an NAC
controller to the system.Click the New button on the Device Manager view.

Step 1. Click the New button on the Device Manager view.

@ Type to add Azure Controller
@ Number to add 1 [1-100]
© Number of Doors 1

0K Cancel

The New window opens.

Step 2. From the drop-down list, select the type and number of controllers you want to configure and the
number of doors, and then click OK.

Step 3. Once the controller type is selected, configure the NAC Controller properties, such as Address
and Port, from the NAC Device Add window.
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Name Type Enabled Ip Address Port Num Of Doors
ZKTecoControllerl  ZKTeco Controller  true 127.0.0.1 ] 1

@ Name ZKTecoController]] i

O Type 7K Teco Controller »

© Enabled

@ Ip Address 127.0.0.1 =

O Port 0

@ Num Of Doors 1

0K Cancel

Step 4. After the device configuration update, click OK and check if the controller is added to the server.

Add Controller using Discover
To use this option, you must connect the controllers to the same network where the server is running before
discovering the controller in the Device Manager view.

Click the Discover button at the bottom of the Device Manager view. Now the Discover job would search for
the controller in the local network database and list all the controllers on the network.
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This View has two panes :

* The Database pane at the bottom is where you can see all the devices or modules that are currently part
of the system database. You can double-click an item in this pane to open its edit view.

* The Discovered pane (top pane) lists the modules or devices that the discovery job found on the network.
Click on the discovered controller and then click on the Add option. Once the Add window opens, check

the configuration properties such as the IP Address and Port of the device. Then, click OK to add the
controller to the server.
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Setup the NAC Network

The setup option lists a view to configure the NAC Network. Under the NAC Device Manager view, click on
the Setup option and configure the server properties.

Step 1. Within the Setup menu, navigate to HTTP Comm Config.

Step 2.
Step 3.

Step 4.
Step 5.

Step 6.
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Enter the IP Address as localhost.

For the Port, enter the port number already set for Niagara Access (NAC Server) in the Niagara
Access Configuration application and click SAVE.

Access the NAC Device Manager to establish and authenticate the connection to the NAC server.

Click on the Authenticate command under the Device Manager view to enter the server
credentials.

Enter the username and password that have already been set for Niagara Access (NAC Server),
and click SAVE .

Username
Password

0K Cancel

Upload NAC Firmware files

The view provides a list of firmware upgrade files for the controller, including the latest versions that need to
be used for uploading the firmware.

Step 1.
Step 2.

Click on NAC Firmware List, and the NAC Firmware UX Manager will open.

Click on the Import Firmware File button to store the firmware file on the server.
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The Store Firmware File on the Server window opens.
Step 3. Click on the Import Firmware File option. The File Chooser window opens.

Step 4. Select the appropriate firmware file for the controller and click 0Open Ok .

Ord Chooser W

null
null

|» © station
00 My Modules

Ord Type:

OK Cancel

Step 5. Click OK to add the Firmware file.

Result
Navigate to the Firmware List in the UX Manager view and observe that a new entry is there with updated file
details.

Discover, Learn, Add, and Match

The manager views, such as the Station Manager - Database view, provide a way to find network modules and
devices, and add them to the system database. The system runs this discovery action as a two-step job.

1. First step: The system discovers (learns) device candidates for inclusion in the system database.

2. Second step: The system presents a list of candidates from which you manually select and add modules and
devices to the database. If you already added devices to the database using a New window, the discover
process lets you match found candidates to existing device records.

NOTE: You do not need to use discovery if you already added a device. If the device shows a valid status,
{ok}, in the Database pane, it is already on line and discovery is not necessary.

The result of the discovery job is a table view, where each row represents a unique module or device.
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Figure 11. Network Discovery view after discover job

4o Monitoring ﬁ Personnel #% Controller Setup

[l Schedules & User Management 5 Backups # Remoie Devices i Access

3 Vﬁ:ﬁﬂ PR (2)%)(8)] s

&

Stztonl localhost fos 4311 {dowm} Peer Takl
entSecurity301 localhost foes 4311 {disabled fault}  Peer Jokl
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5@ B0 [@hlreldes s
N7 1527 HTSWin2012RA2.tridium2012.net fox 1927 fals=

118 _1%28 HTSWin2012R2.tridium2012.net fax 1528 fals=

118 15928 HTSWin2012A2.tridium2012. net foe 1528 fals=

This view has two areas or panes:

* The Database pane (top pane) lists the devices or modules that are currently part of the system database.
You can double-click an item in this pane to open to its edit view.

* The Discovered pane (bottom pane) lists the modules or devices that the discovery job found on the
network.

Discovery control buttons

In addition to the standard control buttons (Hyperlink, Delete, Rename, Filter, Refresh, and Export, the
Database and Discovery panes contain control buttons specifically related to discovery.

Database pane control buttons

The Database pane lists the devices that are currently in the system database. You double-click an item to edit
available device properties.

These control buttons perform unique functions related to discovery:

e @ Discover opens the Discover window, which defines the database search. Based on this information, the
discovery job interrogates the target location for data, such as historical and current values.

e [O/la Learn Mode buttons open and close the Discovered pane in a manager view to show or hide the
control buttons and any discovered items (devices, points, database properties, etc.).

Discovered pane control buttons

This pane displays the results of the discovery job and lists the modules and devices found on the network.
Devices that already exist in the system database appear in the database pane and appear dimmed in the
Discovered pane.

The control buttons in this pane specifically relate to the discovery process.
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* ©]Add discovered item(s) moves one or more discovered items from the Discovered pane to the Database
pane. It is available when items are selected (highlighted) in the Discovered pane. Before the item(s) are
added, a window opens with properties to configure them.

e | &2 Match initiates an action to add a single item to the system database. It is available only when you
select an item in both the Database pane and the Discovered pane of a manager view. This action
associates the discovered item with the selected item that is already in the database—usually an item
previously added off line. The added item assumes the properties defined for it in the database. You can
edit properties after adding the item. (This button also synchronizes similar schedules (subordinate to
supervisor) under a single name.)

About table views

The Alarm Console and other views present information in tables. You can customize this information by
sorting, filtering, editing column order, and by removing and adding columns. In addition, you can export
tables for processing in a spreadsheet or other application. This topic introduces table controls and options.

Figure 12. Table controls and options (People view table)

's Personnel

& Monitoring

fa People rri Badges

ol[@ee@®@Ee@Em ®=(3m0E
A
A Julie Tech Document Lead Technical Writer
gl Miks Tach Documents Technical Writer Il
M Clair Tech Document Technical Writer Il
N Komal GES Lezd Enginzer
P Rashmi GES Engineer
T Vidya GES Lezd System Enginner

* The View Title displays the name of the view.

e Control buttons add, link, delete, filter and work with the displayed data in a variety of ways that are
context sensitive. Tool tips describe the function of each control button. Buttons remain dim until one or
more table rows are selected.

* Column headings indicate the type of data. To sort a table with reference to a column, click once on the

column heading. The up (ascending) or down (descending) arrow on the column heading indicates the sort
order.

e Page display controls indicate the number of pages of data.
e 4| P Previous and next arrows provide incremental control over displaying multiple pages of data.
* Page boxes select the page to view (type the page number in the box and press Enter).
® Scroll bars and mouse wheel provide scrolling options.

Table right-click menus

In table views, controls are located both across the top of the view and in context-sensitive right- click menus
provide options for working with the database records in table views.
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Figure 13. An example three right-click menus

& Hyperlink & Hyperlink & Hyperlink
Summary T Rename — Rename
[y Duplicate @ Delete @ Delete
&7 Show Access History (O Wink Device

[y Show Readers

Ef) show Expirations

© Delete

= Quick Edit

Each menu includes optional actions that are appropriate for the type of table view. The first menu is from
right-clicking a person record on the People view. The second menu is from right-clicking a remote reader

module record in the Remote Module Setup view. The third menu is from right-clicking a role in the Roles view.

The following describes the options in these menus:

* Hyperlink links to the edit view or window for the selected item. It is the same as double-clicking the
table row.

Summary opens the Summary window for the selected item, which shows how item properties are
currently configured. Double-clicking on any row in a table opens the Summary tab, which contains the
same information as the Summary window.

Duplicate opens a New window and populates each property with properties from the selected item.
Using this button speeds the item creation.

Show Access History opens the Access History view for the selected record.
* Show Readers displays an appropriate readers report for the selected records.

Show Expirations opens the Person Access Right Report view.

Delete removes the selected item (row) from the table. This button is available when you select an item.

Quick Edit opens the Quick Edit window for the selected item(s). This feature allows you to edit one or

more records without having to leave the current view.
Rename opens the Rename window with which to change the name of the selected item.
* Wink Device access sends a message to a device expecting to receive a response.

Sorting table data by column

By default, the system displays the records in a table descending order based on the first column in the table.

You can change both the sort order and the column used to sort.

Prerequisites:
The current view contains a table.
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The Alarm Console is a good example of how to sort a table.

Timestamp -
O & 01-Jun-18 9:45:31 AM EDT NiagaraNetwork Station1 Ping Failed Offnormal
O & 29-May-18 5:13:28 FM EDT NiagaraNetwork entSecurity802 Ping Failed Offnormal
O & 28-May-18 9:31:30 AM EDT NiagaraNebtwork MyStation10 Ping Failed Offnormal
O & 23-May-18 1:29:05 FM EDT Remote Reader Module.Door 2.Exit Request Supervised Fault Detected Fault
O & 23-May-18 1:29:04 FM EDT Remote Reader Module.Door 1.Exit Request Supervised Fault Detected Fault
0 & 23-May-18 1:14:31 PMEDT  Nrio Network remoteReader_1 Ping Failed Offnormal
< >

The default view of this table displays alarm records in descending order ( W) by Timestamp. This displays the
most recent alarms at the top of the table.

Step 1. To use a column other than the first column to sort the table, click the column title.
The system displays table records in ascending order ( #&) based on the column you clicked.

Step 2. To change the sort order to descending, click the column title again.
The arrow changes to descending order ( W) based on the column you clicked.

Step 3. To again display information in an ascending order, click a column title.

Adding columns to a table

Each table view opens to a set of default columns. You can add and remove columns as needed.

Prerequisites:
A table view is open.

Step 1. Click the Column Chooser button (&) ).
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The Column Chooser view opens.

Home

*»| People [y Badges |5 Access Rights & Tenants ™

& Monitoring fs Personnel Reports ﬁi Controller §

Additional

Columns for People

6] elallv] (@l
Name Display Name From Type
lastMame Last Name entsec:Person
firsthame First Name entsec:Person
department Department entsec:Person
personType Perzon Type entsec:Person
tenantMame Tenant Mame entsec:Tenant
Row Type entsec:Person S

Report Type
Pre-Filtering

&) Add Column | *® Default Table

R TR T

entsec:Person Last Modified
entsec:PersonZoneloin {person) Person Id
entsec:PersonLdapServerJoin (person) Last Mame
entsec:SupervisorZoneloin (person) First Mame
entsec:Badge {owner) Middle Initial
entsec:Personlnfo (person) Employee Id
entsec:PersonAccloin (person) Department
Person Type W
< >

Step 2. In the lower table, select a node under the From column that contains the properties from which
to choose.
The Property and Linked Property drop-down lists populate with available properties.

Step 3. Select the Property or Linked Property to include and click Add Column.
The system adds the property to the columns table at the top of the view.

NOTE: The addition is not final until you click the Save button ( & ).

Step 4. After adding any additional columns, click the Save button at the top of the view.
The Save window prompts you to confirm.
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Step 5. To confirm the configuration, click Yes.
The system adds the column(s) to the right end of the table.

Deleting table columns

This procedure documents how to delete table columns.

Prerequisites:
The table exists.

Step 1. Click the Column Chooser button ( g ).
The Column Chooser view opens.

Step 2. Inthe upper half of the view, select the row that represents the column you want to delete and
click the Delete button (| @ ).
The system removes the row from the table.

NOTE: The deletion is not final until you click the Save button (& ).

Step 3. After deleting any additional columns, click Save at the top of the view.
The system opens a @Save confirmation window.

Step 4. To confirm the deletion, click Yes.

Editing table column order

This procedure explains how to change the order of the columns in a table.

Prerequisites:
The table exists.

Step 1. Click the Column Chooser button (g ).
The Column Chooser view opens. The top-to-bottom order of the table rows at the top of the
view relates to the left-to-right column order in the target table.

Step 2. In the upper half of the view, select the row that represents the column to move and click the Up
and Down buttons (| A | v | ) repeatedly until you position the property in the desired order.

NOTE: The new order is not final until you click the Save button (| & ).

Step 3. To save, click Save button at the top of the view.
The system opens a @Save confirmation window.

Step 4. To confirm the column order change, click Yes.

About filtering tables

The system displays data in table views. Clicking the Filter button ( ¥ ) opens a Filter window with which to set
up search criteria (the columns to filter on). By defining exact, include, and match case properties, you can
select precisely the records you are interested in viewing. The system uses these criteria to query the
database.

You can define a single filter property or combine properties. Be as precise as you can when filtering records
stored in a large database. Alarm and other data grow quickly. If a query generates a table larger than 5,000
records, a message alerts you that only the first 5,000 will be available for viewing.

NOTE: Filter windows are context sensitive so that the available properties reflect only the data in the
currently active table view. For example, the Filter window contains Timestamp only for tables that have a
Timestamp column.

Wild cards and filter properties

The percent (%) character (wild card) may precede, trail, or surround a filter string. The filter properties:
include, exact, and match case further limit search results.
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Figure 14. Example search with leading wild card

'§ acCcess 4. Access History <y Alarm History 4. [Intrusion History 4. Attendance History 4. Audit History 4. Log Histo

@fi’ 2 H = 2 || &l o " P Page of 11 Page Size

Timestamp * ‘Operation Target Slot Name 0ld Value Value User Name

18-Jul-18 6:56 PM IST Added Crrion Person, N, Komal admin

18-Jul-18 6:56 PM IST Added Orion Person, P, Rashmi

18-Jul-18 6:55 PM IST Login [Services/WebService i Timestamp Todsy v »

18-Jul-18 &:34 PM IST Logout (Timeout) /Services/WebSarvice Operalion |"ri1 || Must Include hd | Case Sensitive

18-Jul-18 6:12 PM IST Login [Services/WebService ] Target [56 [[Must 1ncluds + | W] case sensitive

18-Jul-18 5:42 PM IST Logout (Timeout) [Services)WebSarvice [ slot Name |% Must Indude “ o Case Sensitive

18-Jul-18 5:27 PM IST Login {Services{WebService Llold value |% MustInclude | Case Sensitive
CIvalue I% Must Indude s & Case Sensitive
[l user Name |5 Must Include % | ¥/ Case Sensitive

The example above filters on Station Name using the include and match case properties. A string, such as
%8000 with the include box selected, returns records with the following possible values in the Station Name
column: HO-8000, myStation-8000, but not myStation-HQ.

In another example, the string myStation, with the exact check box selected, returns only results that have
myStation as the complete Station Name. More or fewer characters in the name exclude the record from the

filtered results.

You may add other criteria to further refine this search.

Table 1. Filter properties

Property Description
include Includes results that match the pattern defined by the wild card expression.
exact Looks for the specific string text. If you use the percent character, the system looks for the actual percent

symbol and does not use it as a wild card.

match case Configures the search to be are case-sensitive.

String filter functions

These functions are available for use to provide advanced filtering options.

Table 2. String functions

Characters Description

Il Two pipes (vertical bars) define the OR function.

&& Two ampersands define the AND function.

! A pipe followed by an exclamation point define the OR NOT function.

&! The ampersand followed by an exclamation point define AND NOT function.

The following examples illustrate how the functions filter this list of data characters: A, AB, AC, ABC, B, BC, C.
Note the different results.
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Figure 15. String filter examples

ABC, AC

%A% && %C%
%A% && %C% & %B% AC

Filtering data in a table
Filtering tables, such as lists of personnel or the data in the report views, removes records from the view that
you do not need.

Prerequisites:
A table view is open.

Step 1. Click the Filter button ( [= ).
The appropriate Filter window opens. The filter criteria reflect the table column (property) titles.

Step 2. To designate the properties to filter on, enable one or more check boxes.
The selected properties names change from read-only to active.

Step 3. Fillin a value for each property and select or clear the include, exact, and match case check

boxes as needed.
The system constructs a database query.

Step 4. To apply the filter, click Ok.
The system recreates the table and displays the query results based on the filter criteria.
Filtering using time
Timestamp properties are available in many filter windows.

Step 1. Click the Filter button ([ |) in any table view, such as the Alarm Console view.
A Filter window opens.

/| Activity Timestamp |Today | »

[ ] Activity |

[ owner |% Must Include « "] Case Sensitive
[l manual Entry false ~

[ ok |[ cancel

The example shows the attendance history Filter window.

Step 2. Click the selection box next to a general period of time for a Time drop-down list (Noxrmal Time,

Ack Time, etc.)
This activates the property. The time options list offers preset periods (Today, Yesterday, Month-

to-Date, and others).When you choose the Time Range, the system displays a clock button (|
).

Step 3. Choose a time option from the drop-down list.

Step 4. If you chose Time Range, click the clock icon.
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The system opens the Time Picker window on which to specify a range of time values.

“ min [20 vHapr w2017 [[12 v]{oo v][pM v]EDT

max[20 v apr w2017 [[0s {00 v]|[pM v|EDT

Notice that the Time Picker window has min and max properties for specifying a fixed filtering
time range or for choosing an open-ended start and end time.

Step 5. To select a more specific range than the time options offered in the Time list, click the browser
icon (>>) to open the Advanced Time Range Options window.
The system opens the Advanced Time Range Options window and changes the browser icon to
red.

Advanced Time Range Options

Start Time |12 ~ {00 «|/am ]

End Time [12 v oo | am ~|
Days Of Week Sun Man Tue Wed Thu Fri Sat
Schedule @ INune »

0k Cancel

NOTE: Make sure that the inquiry you configure using the filter window and these advanced time
range options makes sense. For example, if you select a specific date using the filter window, and
then exclude that specific day by de-selecting it using the Days of Week properties in this
window, the system responds with a message, Advanced Filtering too Strict.

Step 6. Configure the properties in this window to set specific time ranges and days of week for filtering
tables and reports.

Step 7. Configure the Schedule property to assign specific times to individual days and click Ok.
Schedule works together to further restrict which records display.

Exporting data to PDF or CSV

All views that display the Export button ( .= ) allow you to export the table of data to either a PDF or CSV
(Comma Separated Values) file, which you can import to a third-party program, such as Excel. You may export
all data in the table (includes all pages) or just the page that is currently displayed in the view.

Step 1. Navigate to the view that contains the data to export.

Step 2. To export only selected records, do one of the following:
¢ To select non-contiguous rows, hold the Ctrl key and click each row.
¢ To select contiguous rows, hold the Shift key, and click the first and last row.

Step 3. Click the Export button ([ .|).
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The Export window opens.

[

Title |Di5tri|:|uted Schedule Manager - Database |
Export Range |AII |
File Type |PDF |

Cancel

Step 4. Give the file at least a Title, select the file type, and click Ok.
¢ PDF (Portable Document Format) is for ultimately printing the exported data.

e CSV (Comma-Separated Values) is for processing the exported data in a spreadsheet or other
application.

Depending on your browser, a window opens with options for saving or viewing the exported file.

Quick editing common properties

The Quick Edit window provides a way to edit the most common configured properties for each record in the
database. The properties available to edit depend on the type of record. Many other properties may define
each record. To edit the not-so-commonly-configured properties, access the property sheet for the record
type.

Prerequisites:
The current view shows a table of database records.

Step 1. Select the record to edit.

Step 2. Click the Quick edit button ( [z ) at the top of a view.
The Quick Edit window opens.

1. For the selected records OR all records in view

mpply ko selected items: 2 & Apply to all records with the current Filter|
Department |Engineering o
DPersun Type | »
[ ITenant P |Afton Remote » BB

Superuisur
[ITrace card |Tra|:eOFF ‘E

2. To these properties ’ Dl ” Cancel ] 3. Apply these values

Step 3. Choose to which records to apply your changes:
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* Apply to selected items: n applies the change(s) to the currently-selected records.

* Apply to all records with the current filter applies the change(s) to all records
based on the current table filter.

Step 4. Fill in the values to change and click Ok.
The system updates the record(s) in the database.

Adding, discovering (learning), and matching

Modules and devices, to be connected, or that are already connected to the network need to be identified,
named and added to the system database. To assist with this process, the system runs a discovery job. Using
the results of this job you add the newly-found object or match it to its record that is already in the database.
Once added, you can enable or disable a driver directly from this view by right-clicking on the driver in the
table and selecting Enable /Disable Networks from the popup menu.

NOTE: This section refers to connecting the JACE controllers. To connect other Entsec controllers, refer to the
NAC Network Setup Menu.

Adding remote modules and devices off-line

An off-line device is a module or device for which information about the unit has been added to the system
database before the actual unit is physically installed on the network. The ability to add device records to the
database before the device is physically on the network can speed the implementation of a new system. This
procedure describes how to add remote modules and devices to the system database before they are
physically connected to the network.

Prerequisites:

NOTE: If the remote module or device is already connected to the network (on line), skip this procedure and
add the device using the discovery process.

Step 1. Under the Controller Setup menu, click Remote Devices > Remote Modules > Remote Module
Setup.
The Access Device Manager-Database view opens.

]

ﬂ ﬁn} Ea ﬁ} C:I g L . = =h /-
A

Base Reader Module trus ffault Base Board Reader 000000000000 1.24

Input/Cutput Module trus ffault} Remote Input Cutput 000000000000 1.24

The Database pane lists the devices that are currently in the system database. You double-click an
item to edit available device properties.

Step 2. Click the Manage Devices button ( |4 ).
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Step 3.

Step 4.

Step 5.

Step 6.
Step 7.
Step 8.

The Manage Devices window opens.

How would you like to Manage Devices? ®'Remote Reader Module Device Type  Remote Reader Module

e

i) Add '::'Inpuh.‘ﬁutput Moduls Hame |Rerm:|te Reader ModL = |

h &) Delate Initial Doors

(7 Rename
,_"j Duplicate

:"31 Copy

Opg Cut

Select the Add option and click Ok.
The Add Device window opens.

Select the option that matches the type of module you are adding, and click Ok.
Another Add Device window opens.

Enter a descriptive name for the module and click Ok.
A new device is added to the Database pane at the top of the view.

Repeat these steps for all modules, up to a maximum of 15 modules.
Physically install each module.

Discover the module(s) and match each with its record in the database.

Discovering modules and devices

Discovery finds network modules and devices and presents them in a list so you can add them to the system
database or match them with records already in the database. Adding a discovered device is similar to adding
an off-line device with the added bonus that values for some properties are pre-populated because the device
is on line. Matching a discovered device to its record in the database completes a configuration that you
started off-line. Whether you add or match, you can edit the configuration of each device later.

Step 1.

Step 2.

32

Under the Controller Setup menu, select Remote Devices > Remote Modules > Remote Module
Setup.

The Access Device Manager - Database view opens. The Database pane lists the objects (if any)
that are already added to the database. On initial setup, there may be no objects in the Database
pane.

NOTE: If a device appears in the Database pane, and its status shows {ok}, it is already on line
and information about it is in the system database. Discovery is not necessary.

At the top of the view, initiate the discovery job by clicking the Discover button ( g3 ).
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Step 3.

Step 4.

The system runs a device discovery job to learn (find) and display the devices that are available on
the local area network A progress bar appears over the view. When the discovery job finishes all
discovered objects appear in the Discovered pane below the Database pane. The result of the
discovery job is a table-based view with two panes, where each row represents a unique device.

= | 2 =
# @) 5] AIBPE
A
Base Reader Modul= true ffault} Base Board Reader 000000000000 1.34
Remote Reader Module true ffault} Remote Reader 000000000000 1.34
Remote Reader Modulel  true Tokl Remote Readar 000010652c?E  1.34 1.34
Discovered
9| &) O A IR
1 Remote Reader 0001085278 1.34 Remate Reader Module1

* The Database pane (top pane) lists the modules and devices that are currently in the system
database.

* The Discovered pane (bottom pane) lists the modules and devices found on the network by the
discovery job. Devices that already exist in the system database appear in the database pane
and appear dimmed in the Discovered pane.

To close the Discovered pane, click the Learn Mode button ([ ).
The Discovered pane closes.

To open the Discovered pane again, click the Learn Mode button again (| 5/).
The Discovered pane opens.

Adding discovered objects

After a discovery job runs, devices that are connected to the network, but are not in the database need to be
identified, named and added to the database.

Prerequisites:
The discovery job found devices that need to be added (they appear in the Discovered pane, but not in the
Database pane).

Step 1.
Step 2.

Step 3.

Step 4.

Select one or more discovered device(s) and in the Discovered pane.

To add the device(s) to the database, click the Add button (| g |) or right-click the selected row
and click Ada.

The Add button is available when you select (highlight) a device in the Discovered (bottom) pane.
The Add window opens. The properties in this window already contain acceptable values,
otherwise communication to the device would not have occurred. Usually, only the name needs to
be changed. You can always edit these properties later.

Change the name and click Ok.
The system adds the device(s) to the database and the device(s) appear in the Database pane.

Double-click the module row in the Database pane.
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An edit window opens.

Step 5. For each added module, edit the available properties, including defining the Alarm Class and
click Save.

Matching discovered objects

After a discovery job runs, devices or modules that were added to the database while off-line need to be
matched to the installed devices.

Prerequisites:
The discovery job found devices that need to be matched.

Step 1. Select a device row in the Database pane and the same device row in the Discovered pane.

NOTE: Match is strictly a one-to-one function for discovered-to-database objects. Match is
unavailable any time you select multiple items in either the top or bottom pane.

Step 2. To match the device with its record in the database, click the Match button (| &) or right-click the
row in the Discovered pane and click Match.

Step 3. To edit the database record for the matched module, double-click the module row in the Database

pane.
An edit page opens. Matching populates the discovered device’s address values. These properties
are valid, otherwise communication to the discovered device would not have occurred.

Step 4. For each matched object, edit the available properties, including defining the Alarm Class, and
click OK.
The system adds the device or module to your station database. You can always edit the device
component properties after you click OK.

Finding a device to match

The wink action makes it easy to match the entry in the Discovered pane with the actual hardware device that
the entry represents. This can be especially helpful when you have a lot of devices on your network and are
naming and adding them to your database.

Right-click the device in the Database pane and click Wink Device.
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Getting Started

The device comes on line and cycles the first relay output on and off for 10 seconds.

NOTE: The Wink button changes from green to yellow while the wink action is active. Another way to wink a

device in the Database pane is to select it and use the Wink control button ( o ) at the top of the view.

Configuring inputs and outputs

This procedure documents how to configure inputs and outputs. Configuration properties are similar for inputs
and supervised inputs. This procedure describes how to configure existing inputs and outputs. Input and
output configuration is similar, with differences noted in the procedure. These inputs are described in more
detail in the mounting and wiring documents listed in the Setup prerequisites topic.

Step 1. From the main menu, click Controller Setup > Remote Devices > Remote Modules > Remote

Module Setup.
The Access Device Manager- Database view opens.

Step 2. Double-click the module that contains the point(s) to edit.

The Edit Module view opens.

Step 3. Select the Additional Points tab.

Step 4. To rename an individual point, click the Manage Devices button (|| ).

Step 5. Click the point link to configure.

The Edit Point view opens. The point name appears in the view title and the configuration tab

displays by default.

Step 6. Configure the properties on each tab and click the Save button.

Assigning and unassigning items

In many views, you can use the learn mode with the AssignUnassign and buttons to add or remove items from

the Database view.

Step 1. Open a table view with a Newly Assigned pane;
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Step 2.

Step 3.

Step 4.

Newly Assigned

onr)l@ @DLE=
A

George Curious

Unassigned

olBl(@ (¥

Friendly Mancy Finance
George Curious

Sanders Randy

Scope Pearl Training

Click the Assign Mode button ([ g/ ).
The Unassigned pane opens with a list of possible items for adding to the Newly Assigned pane at
the top of the view.

To assign an item, select one or more items in the Unassigned pane and click on the Add (Assign)
button ([ ).

Newly assigned items are dimmed in the Unassigned pane and no longer available after you save
the assignment.

To remove an assigned item, select one or more items in the Assigned or Newly Assigned pane
and click the Unassign button (| & | ).

Mapping cameras connected to a Supervisor PC

To associate alarms in a host controller with one or more video cameras installed on the Supervisor PC, you
map the camera(s) in the host controller.

Prerequisites:
You are connected to the host controller’s station.

NOTE: Not all video drivers support remote video streaming and mapping. Refer to your camera
documentation.

Step 1.

Step 2.

36

Open the Station Manager by clicking Controller Setup > Remote Devices > Station Manager.
The Station Manager-Database view opens.

Select the station name and click the Summary button ( ).
The station’s summary page opens.
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Step 3.

Step 4.
Step 5.
Step 6.

Step 7.

Click the Device Exts tab.
A summary list of the device extensions associated with the station opens.

Click the Cameras hyperlink.
The Camera Manager view opens.

To discover cameras, click the Discover button ( [agg| ).
The system displays the found cameras in the Discovered pane.

Select and add the cameras connected to the Supervisor station.

Mapping cameras connected to a remote controller

To view in a Supervisor station the video streams coming from one or more video cameras installed on a
remote controller, you map the camera(s) to the Supervisor station.

Prerequisites:
You are working in a Supervisor station.

NOTE: Not all video drivers support remote video streaming and mapping. Refer to your camera
documentation.

Step 1.

Step 2.

Step 3.

Step 4.
Step 5.
Step 6.

Step 7.

To open the Station Manager, click System Setup > Remote Devices > Station Manager.
The Station Manager view opens.

Select the station row and click the Summary button ( ).
The Summary tab opens.

Click the Device Exts tab.
A summary list of the device extensions associated with he station opens.

Click the cameras hyperlink.
The Camera Manager view opens.

To discover cameras, click the Discover button ( [gg| ).
The system displays the found cameras in the Discovered pane.

Select and add the cameras connected to the remote host.
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Chapter 2. Special event scheduling

The system supports two types of schedules: weekly schedules, which define normal weekly hours of operation
and one-off special events, and calendar schedules, which define recurring special events. The Installation and

Maintenance Guide provides a procedure for creating weekly schedules. This chapter covers the scheduling of
special events.

Weekly schedules

A weekly schedule defines normal working days. Two types of special events configure exceptions to the
normal weekly schedule:

* One-time only events, such as three hours off to view a solar eclipse, apply to individual weekly schedules
only.

Recurring special events, such as Christmas Day or Martin Luther King Day, reside on a calendar schedule.
Weekly schedules reference calendar schedules. Since special events on a calendar schedule apply to any
weekly schedule that references the calendar schedule, you can globally change the days of recurring
special events in all weekly schedules by editing the calendar schedule.
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Figure 16. Weekly scheduler view

&d” Monitoring ﬁ Personnel & Controller Setup ﬂ'}, Threat Levels

B schedulez B User Management 0= Backups #' Remote Devices @' Access Setup  @F |

k= Save | ) Schedules

Summary Scheduler Schedule Setup Special Events  Access Rights  Intrusion Pins
M B &) QD

Sun Mon Tue Wed Thu Fri Sat

Granted Denied Granted Denied Granted Denied Granted

Start: (11 ™[{30 v||pM v|EDT
Finish: [11 v [{30 v|[PM v|EDT

Output: L null

The Default Output for this Schedule is currently set to "Denied {ok}".

The scheduling interface uses a simple calendar view. The screen capture is an example of a schedule used to
configure access rights for a daily shift.

All special events on a weekly schedule take priority over regular weekly events. Among special events, you
define relative priorities by the order of listing in the Special Events table, as follows:

* Highest priority is at top of list. These special events, when active, always occur.

* Lowest priority is at bottom of list. These special events occur only if not overlapped by other special
events that are active during the same period.

Special events
The system provides multiple ways to define a special event:
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* By specific date (Date option)
¢ Based on when the special event begins and ends (Date Range option)

* By defining a movable date based on the day of the week, the week within any month, and the month in the
year (Week and Day option)

* By a combination of day within the month, month within the year, day of the week, week of the month and
year (Custom option)

* By referencing a Calendar Schedule, which defines a recurring event.
NOTE: Special event are currently not supported for NAC Controllers.

Adding a special one-time event

This procedure adds a one-time event to a weekly schedule.

Prerequisites:
The weekly schedule exists.

Step 1. Open the schedule.

Step 2. To add the special event, click the Add button.
The Add window opens.

Step 3. Enter at least a descriptive name (Display Name) for the special event.
The name defaults to Event. You can change it later to something else.

Step 4. To change a special event’s priority, select it and use the priority arrow buttons.

H.J.& =] o

January 1 Diate: 1 Jan
July 4th Cata: 4 Jul
Christmas
Edit
=
Ewvent
A, Move Up
Rename
o Delete

Adding a special event by referencing a calendar schedule

Special events defines exceptions to the weekly schedule as special events. A special event may be a one-time
occurrence, such as three hours off to view a solar eclipse, or it may be a recurring special event, such as
Christmas Day or Martin Luther King Day.

Prerequisites:
The schedule exists.

Step 1. Click Controller Setup > Schedules, double-click a schedule, and click the Special Events tab.
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Step 2. To add a new special event, click the Add button (| o).
The Add window opens.

Step 3. To add the special event by referencing a calendar schedule, enter a Display Name for the event,
select Reference for Type, and click Ok.
The Edit window opens with a drop-down list of the ORDs for all the calendar schedules in the
system.

Save Schedule

V51

Summary Scheduler Schedule Setup Special Events  Access Rights  Intrusion Pins

Conference

Event

shot:/Services/ EnterpriseSecurityService/calendarSchedules/Holidays

Step 4. Select a calendar schedule from the drop-down list and click Ok.
The newly-created special event exists in the Special Events table, but still needs to be added to
the Events calendar. The table row remains selected for further editing, except for Type.

Step 5. With the special event selected, click in the right-side Events column and drag to define the event
start and end times.
The system blocks out the time by highlighting it..

summary Scheduler Schedule Setup Special Events  Access Rights  Intrusion Fins

oB)avoEe (@ o)(@(e)(m

Events

Conference Date: 12 Apr 2019 Granted

Event Reference: slot:/Services/EnterpriseSecurityService/calendarSchedules/Haolidays

The Start, Finish, and Output properties work the same as on the Scheduler tab of the Add
New Schedule view. You can also right-click in the column for an event menu. This is useful to add
an all-day event or set the entire day to the schedule’s default value.

NOTE: You must drag to add the event to the Events column of the calendar for it to occur. If the
Events column is empty, the special event relinquishes control back to any lower-priority
scheduled events, and finally intermingles with the weekly schedule. To completely override the
weekly schedule, configure a special event for the entire day.

Step 6. Once you have several events on the schedule, use the Move Up and Move Down priority control
buttons (| a | w|) or right-click actions to prioritize the events.
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All special events take priority over regular weekly events. Among special events, the order of
listing in the Special Events table defines the relative priority of the events, as follows:

* The highest priority special event is at top of list. High-priority events, when active, always
occur.

* The lowest priority event is at bottom of list. Low-priority events do not occur if other special
events, which are active during the same period, overlap them.

Setting up holidays and other special events on a calendar schedule

You configure holidays and other special events on a global calendar schedule. Other weekly schedules include
holidays and special events by referencing the calendar schedule that defines them. This way, if you use
multiple schedules, you have to set up holidays only once.

Prerequisites:
This procedure explains how to set up a calendar schedule with holidays and other special events.

Step 1. To access the Calendar Schedules view, click Schedules > Calendar Schedules.
The Calendar Schedules view opens.

Step 2. To add a calendar schedule, click the Add button ([ @ ).
The Add New Calendar Schedule view opens.

Step 3. Enter a name for the calendar schedule in the Display Name property.
Step 4. To add an event, click the Add button (|3 | ) on the Events tab.
Step 5. Enter a name for the holiday or event in the Display Name property.

Step 6. Do one of the following:

* If the special event occurs on a single, specific day, select Date for Type.The four options
work together to identify the single date. For example, if you select a weekday of Tuesday,
month of 5, and set the remaining properties to Any Day and Any Year, the special event
occurs only on a Tuesday that falls on the fifth day of any month in any year. If a month does
not have a Tuesday the fifth, no event is scheduled to occur that month.

* If the special event takes place over two or more days, select Date Range for Type.The
three options work together to identify the beginning and ending dates. While the start day
can be after the end date, this only makes sense if year property is set to Any Year. For
example, the start day can be in December and the end date in March indicating that the
event occurs during December, January and February.

* If the date of the special event differs each year, but you can define it based on the day of
the week, the week in the month, and the month in the year, select Week and Day for
Type.The three options work together to identify the date. For example, if weekday is set
to Monday, week to 3, and month to February, the event occurs only on the third Monday
in February.

e The Custom option is the most flexible, allowing you to configure any conceivable date. An
example of where you might use this option is for the Thanksgiving holiday in the U.S.,
which is always the fourth Thursday in November.

Step 7. Define the date, day or range and click ok.
You can make only one selection for each property. This includes an Any. . . option, in addition to
the specific options.
The system creates the special event.

Step 8. Configure the schedule properties on the Schedule Setup tab and save the schedule by clicking
Save.

NOTE: You can move between tabs without losing unsaved data, however, you must click the
Save button before leaving the view or data are lost and no new schedule is added.
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Exporting a schedule to a CSV file

This procedure documents how to export a schedule as a CSV file.

Prerequisites:
You start out working on a Supervisor station.

Step 1.

Step 2.
Step 3.

Step 4.

Step 5.

From the main menu, click System Setup > Schedules.
The Schedules view opens.

Select the schedule to export and click the Export button (| ]).

Select csv for File Type.
The window changes size.

.

Title Schedules
Export Range | All b |
File Type

Ok || Cancel

To continue, click Ok.
The system prompts to confirm the download and downloads the CSV file.

Save the file to a location where you can be sure to find it.

One way to discover and export schedules

You may use the Join (Add) Station view to discover and export schedules.

Prerequisites:
You are working in either the Supervisor or a controller station using the web Ul.

Step 1.
Step 2.

Step 3.

44

If needed, return to the main menu.

Click Controller (System) Setup > Remote Devices > Station Manager.
The Station Manager - Database view opens.

Select a station in the database and click the Join button (| = |).

Niagara Enterprise Security Facility Manager's Guide
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The Add Station view opens.

Add entSecurity&]

Ty Retrieve Import Status | «) Reset Inipart Status ” 15 MiagaraNetwork

Step 1: Make sure the System Date Times are SYN hronized within 1min of each other,

Supervisor Tine

Subordinate Tve Ti-Sep-09 0:44 AW EDT (T Synchranize Tims

Timwe Difference 1rrdr

Step 2: Use the Distributed Schedule Manager to import schedules.

Distributed Schedule Manager |

Step 3: Make sure the database will be imported properly.

Record Type Imnport Stabus
Tenants Hot Configured
Keypad Formats Hot Configured

Whegand Formats Motk Conhigured
S |

pilged

Miagara Indegration It M
Aooess Rights ot L crhgurned
i

Irebrrsion Fins

Above is a view of the link that takes you to the Distributed Schedule Manager view.

Step 4. Click the Distributed Schedule Manager link.
The Distributed Schedule Manager - Database view opens.

Ay Threat Levels

" Monitoring #% System Setup

mzl@eoe @EF 050

MNidydlc

Iramewor

[ Schedules & User Management A= Backups &=} Remote Devices #F% Access Setup &% Intrusion Setup

Display Name / Usage Status Out Source Out MNext Time Next Value Supervisor Id

After Hours Access Right  {ok} Default Qutput false {ok} 09-Jan-19 6:00 PM EST  true {ok} [Services/EnterpriseSecuritySer

Abways Access Right  {ok} Week: wednesday true {ok} 10-Apr-19 12:00 AM EDT true {ok} [5ervices/EnterpriseSecuritySel

Weekend Access Right  {ok} Default Qutput false {ok} 12-Jan-19 12:00 AM EST  true {ok} [Services/EnterpriseSecuritySer

Waorking Hours Door Unlock  {ok} Week: wednesday true {ok} 09-Jan-19 6:00 PM EST  false {ok}  /Services/EnterpriseSecuritySel
Discovered

soonc

Q| = Ealar

Display Name Path Supervisor Id  Type Sir

B-to-6 Schedule  slot:/Services/EnterpriseSecurityService/schedules/$3642dto32d6$205chedule MNULL schedule:Boolean5chedule

Step 5. To discover additional schedules, click the Discover button ( 33 ).
The Discovered pane opens with the additional schedule(s).

Step 6. Select the schedule records to export in either pane.
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Step 7. Click the Export button (|, |) for the pane.
The Export window opens.

[

Title |Di5tri|:|uted Schedule Manager - Database |
Export Range |-ﬁ-|| |
File Type |PDF |

Step 8. Fillin the properties and click Ok.

Another way to discover and export schedules

This method uses the Station Device Properties view to discover and export schedules.
Step 1. If needed, return to the main menu.

Step 2. Click System/Controller Setup > Remote Devices > Station Manager.
The Station Manager - Database view opens.

Step 3. Select a station and click the Summary button in the toolbar.
The Station Device Properties view opens.

Step 4. Choose the Device Exts tab and click on the Schedules link.
The Distributed Schedule Manager - Database view opens.

Step 5. Click the Export button ([ .|).
The Export window opens.

Step 6. Fillin the properties and click Ok.
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Chapter 3. People management

For the purposes of this chapter, people include tenants, employees (personnel), and visitors. Managing the
information the system maintains for these people includes creating and editing tenant records, individual
personnel (employee) records, monitoring access, and viewing reports.

This work must be done in the Supervisor station.

Creating a new tenant

Tenants separate personnel based on the company they work for. This is important when managing a multi-
company building.

Step 1.

Step 2.

Step 3.
Step 4.

Click Personnel > Tenants
The Tenants view opens.

Click the Add (| @ | ) button.
The Add New Tenant view opens.

& save | [2) Tenants

Summary Tenant Niagara Integration IDs Intrusion Pins People Badges Threat Level Groups Access Rights &

Tenant Na me|| |

Description

Provide the Tenant Name and an optional Description for the tenant.

Configure the individual tabs for each tenant and click Save.

Each tab provides a set of standard control buttons and two tables. The tables include assigned
and unassigned assets (people, integration IDs, access rights, and badges) to associate with the
specific tenant.

The new tenant is created and the edit tenant view opens with the newly created tenant
properties.

Editing an existing tenant

Once created, you may edit tenant information as required.

Step 1.

Step 2.

Click Personnel > Tenants.
The Summary tab of the Tenants view opens.

To edit a tenant, double-click the tenant row in the table.
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Step 3.

The view associated with that particular tenant opens.

&d” Monitoring *» personnel ﬁ“‘ Controller Setup ,r_'i'j, Threat Levels

s People fii Badges ‘§ Access Rights & Tenants ™, Additional Personnel Data

Save || &) Tenants

summary Tenant MNiagara Integration IDs Intrusion Pins People Badges Threat Level Groups

PA Company

[ Type: P Tenant

(O Tenant Name: A Company

4 Niagara Integration IDs > Intrusion Pins g3 People

4 Lighting [1] Pin Ent Sec 4 Sanders, Randy

This view displays no updated information until you enter data using the remaining tabs and save
the updated information. The Summary tab may also include context-appropriate lists of the
integration ID, people, badges, and access rights associated with the tenant.

Edit the information on each tab for the selected tenant and click Save.
The Summary tab of the Tenants view updates.

Creating a person record

This procedure documents how to add person records in the station database.

Prerequisites:
Access rights and person types have been created.

Step 1.

From the Home menu, click Personnel or expand Personnel and click People.

Step 2. click Add New Person ([ @ |).

48
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Step 3.
Step 4.

Step S.

The Add New Person view opens.

People management

»

»

b

E save || ) People
Summary Person Access Rights Badges
Last Name |Cruise
First Name [Tdm| ®
Middle Initial
Employee Id
Department
Parson Type |
Tenant > |Nane
Supervisor
Trace Card
PIM (number unl',r}:| |
PIN
Confirm PIN: | |
Portrait =

Fill in at least Last Name, First Name, Department and Person Type.

To assign one or more access rights to the person, click the Access Rights tab.

You must assign at least one access right.

When you are finished, click Save.

Editing an existing person record

This topic documents how to edit existing person records

Prerequisites:

One or more records for the person exist in the station database.

Step 1. From the Home menu, click Personnel or expand Personnel and click People.

Step 2.

Do one of the following:

* To make available all data for editing, double-click the person row in the table and click the

Person tab.

¢ To edit only essential information (Department, Person Type, Tenant, Supervisor, Trace
Card, Add Access Rights, and Remove Access Rights), select the person row in the table

and click Quick Edit (/[= ).
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The Quick Edit window includes the most frequently-changed properties.

|:| Department |Human Resources | >

|:| Person Type

| »

D Tenant
D Supervisor
[ |Trace card

>

[ |add Access Rights

>

[ | Remove Access Rights [} Mone

g

If you opened the Person tab, in addition to the same properties as those available on the Quick
Edit view, you can change the person’s PIN and badge.

Step 3. Do one of the following:

¢ If you selected a quick edit, choose to which records you want your change to apply, make
your change and click OK. You are done.

® On the Person, Access Rights, and Badges tabs, make your changes and click Save.

Step 4. To return to the People view at any time, click People.

Combining person records

On occasion you may find two person records in the station database for the same individual. Both may contain
needed information. This procedure uses the match feature to combine the records so that you do not have to

delete and re-enter information.

Prerequisites:

Two records for the same person exist.

Step 1. From the Home menu, click Personnel or expand Personnel and click People.

Step 2. Ctrl + click to select the two records and click the Match button (| z|).
A window opens with the properties as configured.

Step 3. Select the properties to keep from each record and click OK.
The system combines properties and saves one record, deleting the other.

Creating a PIN for a person

A PIN may be required along with a badge (card) to gain access to a building.

Prerequisites:

You are working in the web Ul, usually on a Supervisor PC.

Step 1. To open the personnel record for the individual that needs the PIN, click Personnel.

50
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If the person is not already in the database, click the Add button (

) and create a person record.

Step 2. Filter the table to locate the person, double-click the person row in the table or select the person
role and click the Hyperlink button (& ).

Step 3. Click the Person tab.
Step 4. Enter and confirm the PIN and click Save.

Filtering personnel records by tenant

If each person in the database has the Tenant property defined on their personnel record, you can sort the
table in the People view to display only personnel assigned to a specific tenant or tenants.

Step 1. Click Personnel.
The People view opens.

Step 2. Click the Filter button (=)
The Filter window opens.

... Last Name |% Must Include ~ | | Case Sensitive
L] First Name |“Hu Must Include ~ | Case Sensitive
L] Department |“Hu Must Include ~ | [*/| Case Sensitive
[ person Type |% Must Include ¥ Case Sensitive
Tenant Name|FGH Company ||Mu5t Include v| Case Sensitive

Step 3. Click the check box next to Tenant Name, replace the percent symbol (%) with the tenant name,
and click the Ok button.
The system displays only personnel for the tenant.

Assigning an access right to a person

The system grants access to a person by matching the access right on the person’s personnel record with the
access right that is associated with a door’s reader. This procedure documents how to assign or change an
access right on a personnel record. an individual person may have multiple access rights.

Prerequisites:
The personnel record for the person exists in the Supervisor station database. You are working at the
Supervisor PC using the web Ul.

Step 1. On the home page, click Personnel.

Step 2. Locate the person (you may need to filter the personnel records), and double-click the record or
select it and click the Hyperlink button ([ ).
The personnel record opens to the Summary tab.

Step 3. Click the Access Rights tab.
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Step 4. To display the available access rights, click the Assign Mode button (|5 ).
The system retrieves the available access rights and displays them in the Unassigned pane.

Step 5. Select the right to assign, click the Assign button (| &), and click Save.

Access rights limited by time range

You assign specific rights to personnel. At the time you make this assignment, you can limit the person’s use of
the right based on a time range.

This time range is not the same as using a schedule to specify when the access right itself is effective. This only
relates to a an individual person's ability to use the access right and not the access right's validity or availability
for other personnel. For example, one person may have an access right assignment with an effective time
range of 1 day while another person may have the exact same access right assignment with an effective time
range of 2.5 years.

When access rights are assigned to a person the default time range (Start Date and End Date) of that
assignment are always in effect. This means that, unless the time range of this person’s access right assignment
is changed (using the Change Assignment Properties window) the access right is immediately effective and
never ends.

Editing access right effective date and assigned threat level

Access right Effective Date and Assigned Threat Level apply only to a single access right assignment. To
change these properties, you navigate to a view that includes both the person and the assigned access right.
The following steps describe how to change these properties starting from the Access Right view. Similar steps
may be used to change these properties starting from the Add New Person and edit person views.

Step 1. From the main menu, select Personnel > Access Rights.
The Access Rights view opens.

Step 2. To edit the access right, double-click its row in the table.
The edit view opens.

Step 3. Click the People tab and highlight the person whose access right effective date you want to
change.

Step 4. In the toolbar menu, click the Change Assignment Properties button ( = | ).
The Change Assignment Properties window opens.

Step 5. Configure the properties: Start Date and End Date and Assigned Threat Level, and click the
Ok button.
The access right properties are changed.

NOTE: Changing the Assigned Threat Level in an access right breaks the connection between
the access right and the threat level defined by the access right's associated threat level group.
Future changes to the threat level as defined in the threat level group will not affect the threat
level that has been configured directly on an access right.

Step 6. To update the database, click the Save button at the top of the view.

Restricting available information by tenant

In a system that supports multiple tenants, data must be restricted so that only authorized system users may
gain access to the information that applies to a specific tenant. The information that can be controlled by
tenant includes: personnel, badge, access right, intrusion PIN, Niagara Integration ID, user, and tenant records.
If the Tenants property on a user record identifies a specific tenant value, that user can view only personnel,
badge, access right, etc. information, which contains the same Tenants property values.

Prerequisites:
You are working in a Supervisor station. You have created tenant records for all tenants in the building
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Step 1.
Step 2.

Step 3.

Step 4.

Step S.

Result

Create or edit a system user, access right, intrusion PIN or Niagara Integration ID.

For each record, click the chevron (>>) to the right of the Tenants property, select the tenant from
the Ref Chooser window and either click the Assign button (| |) and click Ok.
This associates the record with the specific tenant.

To limit the records that are available based on the current tenant, click the Tenant Filter icon ( ()
in the top right corner of the view.
The Tenant Filter window opens.

Tenant Filter

P |2 Tenants

| ok || cancel |

Click the chevrons to the right side, select the tenant from the Ref Chooser list, click the Assign
button (/@ | ), and click Ok.

The system hides restricted information (data assigned to a tenant other than the current tenant)
and the Tenant Filter icon changes to a lock icon ( []). More than one tenant may be added the
viewing restriction by using the Tenant Filter window. You add or remove tenant filters to show or
hide information.

To remove the restriction, click the lock icon, and click the X icon to the right in the Tenant Filter
window.
All data are available for viewing.

The Tenant Filter window can restrict information that the current user sees in several specific views. When
using this feature, be aware that:

* The system filters information a user can view based on the Tenants property values that are associated
with the user. For example, “Tenant A” and “Tenant B” cannot view “Tenant C” information because it is
not available to them.

* If atenant is assigned a single Tenants property value, the Tenant Filter window opens as read-only, since
no additional filtering is available.

Managing occupants in an access zone

Normally, occupants enter and exit an access zone by scanning their badge at a card reader. This procedure
allows you to manually update who is currently in the zone and to remove occupants from the zone.

Prerequisites:
The access zone exists in the local station. Your role allows you to change access zone properties (write

enabled).
Step 1.

Step 2.

Step 3.

From the main menu, select Controller Setup > Access Setup > Access Zones.
The Access Zones view opens

Double-click an access zone row in the table.
The edit view for the access zone opens.

Click the Occupants tab, and click the Assign Mode button (| 5|)
A list of the personnel currently in the zone opens in the Assigned pane, and a list of personnel
who are authorized to enter and exit the zone opens in the Unassigned pane.
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Step 4. To manually add personnel to the zone, select one or more persons in the Unassigned pane and
click the Assign button ([ ).

The system adds the person to the list of Assigned occupants in the zone. To manually remove an
occupant from the station’s access zone, select the person row in the Assigned pane and click the

Unassign button (| © ). The system removes the person from the zone.
Step 5. If a number of people have left the zone without using the card reader, click the Access Zone tab
and configure the Passback Timout and Reset Occupancy Enabled properties.

¢ Establishing a Passback Timeout allows people to re-enter a space after the time-out expires
without triggering a passback violation.

e Configuring a Reset Occupancy Time removes all occupants from a zone at a defined time.
After the set time passes, occupants may re-enter.

Only system users whose role is configured with access zone write enabled may change these
properties.
Monitoring door entries
This feature selects a door (card reader), and displays the photo and the name of the person associated with a
badge swipe.

Step 1. Starting from the home (main menu view, click Photo ID > Photo ID Viewers.
The Photo ID Viewers view opens.

&d” Monitoring ﬁ Personnel ﬁ"' System Setup " Photo 1D

&5 Photo ID Network :: Photo ID Viewers
J@en BE@C
A

PhotolDViewer - -

PhotolDViewerl = =

Step 2. Double-click the PhotolDViewer row.
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The viewer window opens.

f Home & Monitoring &g Personnel

“& Photo ID Network [ T Y AV

PhotolDViewer

[ Reports g System Setup [GNCIM 4, ThreatLevels  G]HVAC Homepage  &] Temperature Control ] Access Control  §] Cameras 3] 1st_2ndFI_D

e
Drag a Device into a Grid

H P
[0 WebsEntSec01:Door 19 - Dallara_2ne Enp_ 18 1
[0 WebsEntSec601:Doar 20 - 2nd Fir.Se: 5
- Cam1SHaUlers

= MPC-DIF Stairs
= MPC-DIF Offices

ecting., ..

4 | D

MIF-LIBERATE-VECN
< Internet access

The layout above provides a grid for input from two card readers and two cameras. To change
this layout, click the Layout drop-down menu.

Layouk

Add Reader

Setting up the grid involves populating the device list on the left followed by dragging and
dropping the readers and cameras from the list to the surveillance grid.

Step 3. To populate the list, in the lower left corner, click the Add Reader or Add Camera buttons.
The Add Reader or Add Camera window opens.

Step 4. Select the device(s) and click the Add button ([ & | ).
The card readers and cameras populate the left pane of the view.

Step 5. Drag each device name from the left pane to one of the quadrants.
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As soon as someone swipes their badge, the photo associated with the person displays in the grid
along with the feed from the surveillance camera.

-m-ll-mn & Honll s ine) al-“llllul-ll D Hepoain "\r\.llm\rllq- W7 Phalo I &I- Thaat | suwin l_\ll_l_‘,!”rm!:f!h

% Phalo I Holwaik 11 Phota H Wiowars

FhetolDviswer

Drag a Device ko a Grid
- Lobdey

= [y uadasy

[ etieanity Do | Reade |
L) sresenmiy-Doce I Raade 3

wet [ =]

| addRrsder || AddCamess |

You do not see a photo and personnel data along with the photo until someone swipes a badge.
Unlike the example above, you would expect to see the same person in the video feed.

Manually inserting an attendance record

The system’s time and attendance function marks badge transactions with a date and time that a badge holder
arrives and departs work. These arrival and departure times are used by an external reporting system to
calculate and report time worked. This attendance record keeping is handled automatically based on when the
person swiped their badge. On occasion, you may need to make changes to the attendance records.

Step 1. From the main menu, select Reports > Attendance History.
The Attendance History view opens.

Step 2. Click the Add button (| o ).
The manual Add window opens.

Step 3. Fill in the timestamp, activity and owner (person for whom you are entering the attendance
record) and click the Ok button.
The new record appears in the Attendance History view.
Tracing a person’s entry and exit activity

The system monitors a specific person’s entry and exit when you enable the Trace Card property for the
person and for the reader. You can configure this feature when you initially create the person’s personnel
record. This procedure explains how to add it to an already-existing personnel record.

Prerequisites:
You are working in the controller station using the web Ul.

Step 1. From the main menu, click Personnel, locate the person, and double-click their row in the table.
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The edit view for the person opens.

s Personnel

Home || &9 Menitoring

*» People [iy Badges

Home ¢d" Monitoring *s Personnel R

s\ People Ty Badges [§ Access Rights § Tenants ™

& Controller Setup

sa Access Rights & Tenants ™, Additional Persol

i save | [ People | & Add New Person || [ Duplicate Activity Alert Exts  Output Configuration
Summary Person Access Rights Badges st Alert Alarm Class|Medium V| | B vid
Last Name  |Smith Alarm Class|Medium V| B vid
First Name  |Curious
lert Alarm Class|Medium  v| | Bivid
Middle Initial
Employee 1d |1234 Alert Alarm Class|Medium V| | Bivid
Department |.6.ccount|'ng | » Alert Alarm Class B vid
Person Type |Management | » - Alarm Class[Medum V| | Bvid
Tenant TenantA » B @
i 3| Be ed Alert Alarm Class Evid
Supervisor
race cora | EEETSS et Alorm Clasfedun ] | By
PIN PIN (number only):[eeseeese | Alert Alarm Class|Medium v | B vid
Confirm PIN: sssssees
| | ion Problem Alert Alarm Class B vid
. Alert Alarm Class B vid
Frace Card Alert Alarm Classl B vid
Inactive Threat Level Group Alert Alarm Class & vid

<

Step 2. Click the Person tab, and change Trace Card from Trace Off to Trace On.

Step 3. Click the Access Rights tab, double-click the access right assigned to this person, and click the

Readers tab.
The edit view for the access right opens.

Step 4. Double-click the reader assigned to the access right and click the Activity Alert Exts tab.

Step 5. Assign an alarm class to the Trace Card Alert property and click the Save button at the top of

the view.

When the system grants this person access at the designated door, the system also generates a

trace card alarm.
NOTE: If the system denies access for any reason, it generates no alarm.

Displaying the person’s photo on a history report

This feature displays the current photo associated with a history record. You may view the photo associated
with a history record on the following reports: Alarm console, Activity monitor, Access history, and Attendance
history. For example, the report can show the photo associated with the badge used to arm an intrusion zone.

This photo is the one that is on file at the time of viewing the history.

Step 1. From the home view click Monitoring.
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The Alarm Console opens.
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== Monitoring ﬂ System Setup [ Phote ID & Threat Levels

E Alanm Console = 4 Activity Monitor  [f, Video Monitoring

2| a|=|B) &=

®| %
Time Range ©|2to?

Info Timestamp
0 &
[N

Source Message Text Source State

Ping Failed

Priority - Ack State

11-Jul-18 3:43:07 PM IST Phote 1D Network Asure ID Client Devicel Offnormal 150

11-Jul-18 1:59:20 PM IST NizagaraNetwork test Ping Failed Offnormal 150

Step 2. Select an alarm and click the Alarm Details button (
The Alarm Details report opens.

S -

mn
| —
~

algl=|maB

8 Source(s) / 8 Alarm(s)

0 Acked / 1 Unacked
0 Acked / 1 Unacked

Timestamp 11-Jul-18 1:59:20 PM IST
UuItD 2cadbedc-024d-47c3-8706-1403232e5457
Source State Offnormal
Ack State Unacked
Ack Required true
Source Niagaraﬂgtwurk test _ _
local: |station: |slot:/Drivers/NiagaraNetwork,/test
Alarm Class Medium
Priarity 150
Mormal Time null
Ack Time null
User Unknown User

Alarm Transition

Offnormal

Last Update 11-Jul-18 1:59:20 PM IST
Alarm Data B
Back Forward Acknowledge Hyperlink Notes Close

Step 3. Click the person’s name next to person in the Alarm Data section of the properties list.
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The person Summary opens.

g Prospect, Wendy
O Tvpe: & Person

i_ylast Mame:  Prospect
{3First Mame:  Wendy
i_aDepartment:
i 3Person Tepe:

{PTenant:

[[] Badges
(7] ooooo [0]

NOTE: Many data properties on the Alarm Details and person Summary windows are hyper links
that, when clicked, provide additional information.

Easy Lobby visitor management

For systems with integrated visitor management, such as that provided by Easy Lobby, the visitor management
system manages visitor entry and exit. The system automatically adds people when the visitor management
system checks them in, and automatically deletes or disables them when they visitor management system
checks them out or when their authorized visit expires.

A delay between the time the visitor management system checks visitors in or out, and when the information is
available to the system is to be expected. This delay is usually about 30 seconds. Some configuration options,
such as how long it takes to communicate the information from Easy Lobby to the system, require admin
access to Workbench to configure.

For specific procedures that document how to check in a single visitor, multiple visitors, and repeat visitors
refer to the visitor management system documentation. For Easy Lobby, this would be the Easy Lobby SVM
Installation, Administration, and User Guide.

Visitor management with Sine

Sine is a cloud-based visitor management application used by site administrators to manage visitor check-in
and check-out requests.

This application provides these functions:

* Device configuration using the SinePro application

e User hierarchy creation for collaborators and delegators
¢ Site creation

® Pass configuration

¢ Check-in and check-out form creation and editing
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Notification management

Badge printing

Integration with third-party applications
Report generation

Delivery of invitations to hosts

Sine integrates with Microsoft Teams, Slack and WebHook. Sine-Pro can initiate visitor check-in and check-out
requests in Enterprise Security.

Before beginning the configuration, the user must complete the following prerequisites for Sine and Niagara
Station.

Prerequisites

You should provide Sine and station prerequisites before beginning the configuration.

Sine prerequisites

60

Creating a Sine Pro Account

You should create a Sine Pro account as the first step. Refer to the link for creating a Sine Pro Account
Creating Sine Pro account

Creating a site in Sine Pro Dashboard

After logging into the Sine Pro account, you must create a site for the physical location where you intend
to use Sine visitor management Refer to Creating a site (Creating a Site).

Enabling the CalbackService for WebHookThe callback Service needs to be enabled so the Niagara
station can send a response to Sine when the check-in requests are approved or rejected. To enable the
callback service for WebHook, the user must send a request to Sine Team. Follow the below steps to
enable the Callback Service:

1. Log in to Sine Pro account.
2. In the Sine Pro dashboard, click on the Chat icon in the bottom right corner of the screen & and go
to Messages.

3. Click on Send us a message and request the sine team to enable the callbacks and sign in pending for
WebHook.

® Core [ INVITEGUEST < MESSAGING
RLIE )
4y Activity @ 7 §

Activity
(%) Invitations
@ Reports _
= Any Status v
My Passes Hi Amarnath ¥
?
@ Locations Checked out < How can we help?
@ boss Visr FT— R
We typically reply in under a minute
[@ Displays Amarendra V G saw Shammi Agarwal at Honeywell ,Bangalore, Campus 2
o Accepted by AWS integration on 17 Mar 23 13:19 IST.
Visitor bo12345 Checl Search for help Q
Amarendra V G was rejected from seeing Shammi Agarwal at Honeywell ,Bangalore, Your Sine Set-Up Checklist >
Campus 2
P Rec Going paperless | Onboarding Guide >
Rejected by AWS integration on 17 Mar '23 13:16 IST.
Visitor ] ) NP
b-12345 Compliance | Onboarding Guide >
Amarendra V G was rejected from seeing Shammi Agarwal at Honeywell Bangalore, Login & Password Reset >
Apps Campus 2 E | A
. . Rejected by AWS integration on 17 Mar ‘23 13:15 IST. 1
D o g & ) S| ® @
Home Messages Help News
W Workflows
Amarendra V G saw Shammi Agarwal at Honeywell Bangalore, Campus 2 ®om
§  Scheduling . Accepted by AWS integration on 7 Mar ‘23 20:12 IST. Issued 20:12, 7 Mar 2023 N
- Visitor b-7890 Checked out 20:12, 7 Mar 2023
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4. Once it's done and confirmed by the Sine Team, you can proceed with the configuration steps.

Niagara Station prerequisites
¢ Adding necessary features and drivers to Niagara Station

The Niagara station has the license for sineVisitorManagement and the MQTT driver. Contact the Tridium
team to add these features to your license.

* Providing AWS Certificate

The device certificate (AWSCert.crt) must be imported into Niagara station. The device certificate is
provided by the system integrator. For the demo purposes, contact the Tridium team.

Sine configuration

Some procedures occur on the cloud side. Others in the station. This topic summarizes the cloud-side
configuration steps.

e Configure the site's webhook which includes setting up URLs, keys, visitor types and hosts.

e Set up check-in forms.

Configuring Sine and WebHook

A WebHook is an HTTP-based callback function that allows lightweight, event-driven communication between
two APIs (Application Programming Interfaces). Web applications use webhooks to receive small amounts of
data from other applications. The Sine WebHook notifies visitor actions to the UserService. Contact the Sine
System team to enable callbacks. This may take some time.

To configure WebHook:
Step 1. Login to Sine Pro account (https://dashboard.sine.co/#/login).

Step 2. From the Sine Pro dashboard and under the primary menu sidebar on the left-hand side, click on
Locations.

Step 3. If multiple sites are listed, hover over the specific site you need to perform the integration and
click on . Select Settings to open the site dashboard.

Locations

CREATE SITE

Honeywell Campus 2 - BLR & \e
L Team 72/5, Varthur Rd, Kadubeesanahall, Panathur, Bengaluru, Karnataka 560103, India 0

ahalli Village, Varthur Rd, Adarsh Palm Retreat, STRTGTe! G1ael, 0

Apps

Step 4. From the site dashboard and under the menu sidebar, click on Integrations.
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4y Actiity
(5 invitstions Honeywell Campus 2 - BLR DELETE SITE
0 site 72/5, Varthur Rd, Kadubeesanahalli, Panathur, Bengaluru, Kamataka 560103, India
@@ Reports
My Passas
@ Locations - ' Integrations
enera
[Q Hosts . Current Integrations Available Integrations
@ Displays .
e WebHook Sine & Access Control +
L Team
“ Check-in Forms
Check-out Forms @ Generic Access Control & HID +
Notifications
Printing & Microsoft Teams +
Details o] Slack +
& WebHook +
Apps @
$ Cor
W Workflows @
4 scheduiing
~
Step 5. Under Available Integrations, click + next to WebHook to add a new WebHook.
Integrations
General
- Current Integrations Available Integrations
iPa
Passes
WebHook_Sine & Access Control +
Check-in Forms
Check-out Forms 83 Generic Access Control & HID +
Notifications
Printing ) Microsoft Teams +
Integrations
Details ] Slack +
& WebHook +

Step 6. Configure the WebHook as follows:
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Integrations

Edit your WebHook
Configure

Name

ANS

URL

https://0bnxb5thbe.execute-api.us-east-1.amazc

Rejection Message

SEXTERNAL_REJECTION_MESSAGEY

Displayed if a Check-in Request is rejected without a rejection messag

Visitor Types

Visitor Contractor Staff

Courier Delivery
Admin

Status

Enable/Disable yo tegration

DELETE

People management

External ID

ElgRhcptM4qghsobd

API Key

304e27f3-6245-4b49-9032-d9b3f8892d21

Events

Check-in Request
Check-in Reject

Check-in Success

< ]

a

Check-out Success

a

Invitation Create

a

Invitation Update

a

nvitation Delete

CANCEL SAVE
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¢ Name: Enter a name for the WebHook.

e External ID: Use the Host Sync API Key. From the Sine Pro dashboard and under the primary

menu sidebar on the left-hand side, click on TEAM <= "=  3nd then navigate to the
API tab to access the Host Sync API Key. If this is the first time you are using this API Key,
then Generate the API key before using it.

e URL: Webhook connection URL needs to be requested from Sine Team or Tridium Team by
sharing your Account details like Company and Account Id.

* API Key: Fill with some placeholder for now. This will be configured after the Enterprise
Security is set up with the Visitor Integration Service.

* Under Visitor Types, select different types of visitors as needed.

* Under Events, select all check-in events needed to notify Enterprise Security about Sine
actions. Select other Events as required.

Team

About  Collaborators APl Billing

Host Sync API Key

Your host sync AP key can be used to allow the automation of Host directories in Sine

Host sync APl key @

hvj2qcrcuAMFrzYk REGENERATE m

API Key for Host upload

curl -F "file=@HostsFile.csv" "https://apisine.co/v1/host/csv-upload/api-key?remove-hosts=true8isend-emails=false” -H "X-Sine-Api-Key: ® copy

hvj2qcrcuAMFrzYk”

Replace all hosts with CSV (hosts not in data will be deleted)

Send welcome emails to new hosts

Running host upload through your employee directory will override all hosts custom changes and will delete all hosts that have no records in your employee directory.

Step 7. To save the WebHook configuration click SAVE

Visitor integration in the Niagara station

These procedures configure the VisitorIntegrationService in the station.
* Refresh the API key.

* Establish the MQTT connection.

* Set up visitor types and access right mapping.

¢ Add points to the VisitorIntegrationService.

¢ Discover and subscribe points.

Adding the VisitorIntegrationService

This procedure adds the VisitorintegrationService to the station's Services folder.

Prerequisites:
Sine Visitor Management is licensed.
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Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

In Niagara Workbench, open the Visitorintegration palette and drag VisitorintegrationService
component to the Services folder (under Config) in Nav tree.

. Station [EntSecurity) I Config : - VisitorintegrationService / AX Property Sheet ~

Property Sheet

m VisitorintegrationService (Visitor Integration Service)
- - - m Status {0k}
TemplateService ﬁ Fault Cause
O© Timesyncservics [ Enabled @ true

SecurityServi :
@ securitysenice [l ApiKey dc£1480£-2aba-4de2-b603-728052chT02E
m VisitorintegrationService

@ My Metwark

(W Purge Visitors On Checkout ® e

T PlatformServices
Drivers W Subscribe Point null
Visitor Type Access Right Wiegand Format Facility Code Badg

- Palette f (M VisitorType and AccessRight mapping
New

] E] E ivisiturintegratiun

m VisitorintegrationService

@ raints

Right-click VisitorIntegrationService and click Actions > Refresh Api Key.

NOTE: Once the setup is complete, refrain from changing the API key unless required. If you
change the API key, you need to do the entire setup from here on again to ensure completeness.

This action provides an API key to connect to the Sine environment.

Double-click the added VisitorintegrationService in the Nav tree to open the AX property sheet.
Copy the API Key from the AX property sheet and return to the Sine Pro dashboard.

In the Sine Pro dashboard and under the primary menu sidebar on the left-hand side, click on
Locations. Hover over the site you need to integrate, clickon ... , and select Settings to open
the dashboard.

Under the site dashboard's menu sidebar, click Integrations. Under Current Integrations, click on
the WebHook setting & .

Integrations

Current Integrations Awvailable Integrations
AWS & Microsoft Teams +
) Slack 4
& WebHook +
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Step 6. Under Edit your WebHook, enter the API key copied previously from the AX Property Sheet of the

VisitorIntegrationService into the API Key field.

Integrations

Pad Edit your WebHaok
Configure
Pattes
Name
Check-in Forms AWE
Check-aut Forms URL
ations hitpsyDbnxbSthbeexecute- api.us-¢ast - 1.amaze

Frinting Rejection Message

Result
The VisitorIntegrationService is set up in Niagara station.

Setting up the Visitor Type and Access Right mapping

External ID

EigRhptMighsobd

AP| Key

304273 -bedb-4b49-9032-d9b3BEG2421

The Visitor Type and AccessRight mapping table determine the appropriate access rights and badge

details for specified visitor types.

Prerequisites:

The Access Rights with proper Schedules that can be assigned to visitors and readers are already defined and
set up in the Niagara Enterprise Security system. Please refer to Niagara Enterprise Security Guide or follow

the below steps to set up Access Rights and Schedules.

Adding Access Rights and configuring schedules

Step 1. Navigate to Niagara Enterprise Security web application and log in with your user name and

password.

Step 2. Navigate to Personnel > Access Rights. Click on the [g| icon to add a new access right. Give any
name to the access right. Add a schedule to the access right. Click on Save.

TRIDIUM PaWaNL L

B & Monioring
@ & Pomonnel
Poopls
Badgos
Auzass Faghts
Tonants
Addiional Personrel Data
B [ Fepors
@ & Sysiem Selup

@ A Theeal Lovels

Step 3. Go back to the Niagara Workbench and navigate to Config > Services > VisitorIntegrationService

in Nav tree menu bar.
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Step 4. Double-click on VisitorIntegrationService to open the AX Property Sheet and click Refresh.

- Nav

@ My Netwark

tt C

' SecurityService
& VisitorintegrationService
m VisitorType and AccessRight mapp
o Points
© rublishPoint
e SubscribePoint

T PlatformServices

: Station (EntSecurity) ~ : Config

Property Sheet

: VisitorintegrationService #  AXPropertyShest -

[ VisitorintegrationService {Visitor Integration Service)

[ Status

@ Fault Cause
@i Enabled

(W ApiKey
W Purge Visitors On Checkout

W Subscribe Point

[l VisitorType and AccessRight mapping

Q Points

1ok}

.trus

7713fbdd-5b44-4541-8e55-e36ci95a64a8

.true
null .- o)

Visitor Type Access Right Wiegand Format Facility Code Badge Start BadgeEnd  Currer

New

Unrestricted Folder

D Save

7 Refresh

Step 5. To add a new visitor, click New on the Visitor Type and AccessRight mapping property.

MNew

Visitor Type
Access Rights

Facility Code 0

Others

visitor access righta

Wiegand Format 26-Bit Wiegand Format (HID-H10301)

[0-255]

Ok Cancel

Step 6. Configure all the properties and Click OK.
* Visitor Type selects among these types: Visitor, Contractor, Staff, Courier, Others.
* Access Rights selects from a list of rights previously set up in the system.
* Wiegand Format configures the badge layout from the list of previously set up formats.
¢ Facility Code is based on Wiegand Format.
NOTE: For some common configuration issues and their solutions, refer to

VisitorIntegrationService - Configuration Problem Points and Failures.
NOTE: If any mapping row has access rights or Wiegand formats that no longer exist in the
system or are renamed, that mapping row does not exist.
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Station (sineTest)

- Nav Fa]

® My Network

« @ orivers
» @ nisgaraNetwork
@ RdbmsNetwork
@ obixNetwork
@ Photo IDNetwork
@ AbstractMattDriverNetwork

(vww

v @ AwsMgttDevice
» © Alam SourceInfo
v @ points
» © Publishpoint
@ subscribepoint
» [l authenticator
» O Graphics
> @ iles
» & Hierarchy
- Palette 2]
W [X] D | @ visitorintegration

» (gl VisitorintegrationService

» O roints
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Config Services

[y VisitorintegrationService () SubscribePoint

Property Sheet

™ ice (Visitor

[ status

(W Fault Cause

(@ Enabled

(3 ApiKey

(3 Purge Visitors On Checkout

[ Mqtt Subscribe Point

[ VisitorType and AccessRight mapping

Q Points

VisitorintegrationService

service)
(oK}

@ e
32acd29d-bd47-419c-%e15-5a8e205315¢cé

@ e

) 1
) 1

Facility Code Badge Start BadgeEnd CurrentBadg B
50 1
51 80 s1
£ 100 8

po:
Visitor Type  Access Right Wiegand Format

[ Visitor isitor

{3 Contractor contract e

(g Others other access rights 26-Bit Wiegand Format (HID-H10301) 1

»

7/  AXProperty Sheet ~

3]

Unrestricted Folder

 Refresh

Step 7. To edit the properties, double-click the added mapping row.

Adding Points to the VisitorIintegrationService

Publish and Subscribe points configure the station to connect to the Sine application.

Prerequisites:

[ save

VisitorIntegrationService should be added to the Services and the visitorintegration palette is open.

Step 1.

Step 2.
container.

The points folder is added to the VisitorintegrationService.

. Station (EntSecurity) . Config
@ My Network
b ' SecurityService

= ﬁ VisitorintegrationService

v O Points
b © PublishPoint
b B subscribePoint

- Palette

w X 3

] m VisitorintegfationService

» O Points

i visitorintegration

I Services

I VisitorintegrationService

o Points

Property Sheet
© roints (Unrestricted Folder)
b @ PublishPoint {ok}

» @ subscribePoint

b m VisitorType and AccessRight mapping

- {null} @ def

Step 3. Navigate to Config > Services > VisitorIntegrationService.

68

Navigate to Config > Services in Nav tree menu sidebar and expand the VisitorIntegrationService.

Drag the Points folder from the visitorintegration palette to the VisitorintegrationService

/ AX Property Sheet
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Right-click on VisitorintegrationService > Views > AX Slot Sheet. Right-click on retrylnterval >
ConfigFlags. The Config Flags window opens. Remove the check mark for Hidden.

-
-
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Step 4. Double-click on VisitorIntegrationService in Nav tree to open AX Property Sheet.

Step 5. Set Force subscribe interval (in seconds) to 60.

Step 6. Navigate to Mqtt Subscribe Point and click on the downward arrow next to the folder icon. Select
the component chooser and select the ord path for subscribe point
station: |slot:/Drivers/AbstractMgttDriverNetwork/AwsMgttDevice/points/
SubscribePoint and click Save.

. Station (EntSecurity) . Config . . VisitorintegrationService
Property Sheet
r. VisitorintegrationService (Visitor Integration Service)

r. Status {ok}
[l Fault Cause
(@ Enabled @ true
ri Api Key 7713fbdd-5b44-4541-8e55-236c495a64as
@ Purge Visitors On Checkout ® tre
r. Subscribe Point null

Query Builder

) Visitor Type  Access Right Wiegand Format Facility Code Badge Start
[ VisitorType and AccessRight mapping

New Component Chooser

Component Grid Query Editor
Q Points Unrestricted Folder i A

Directory Ord Chooser

File Ord Chooser

History Ord Chooser

Orion Ord Chooser

The value of ord for subscribe point is added.

Step 7. Navigate to PublishPoint under Points > Subscribe Points > ProxyExt, and then click on the
downward arrow next to the folder icon. Select the component chooser and select the ord path
for PublishPoint as station:|slot:/Services/VisitorIntegrationService/Points/
PublishPoint and click Save.
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Result

: Station (EntSecurity) I Config / AX Property Sheet

VisitorintegrationService

Property Sheet
oo

[l Enabled @ true

(8 ApiKey 7713fbdd-5b44-4541-8255-236c495a64a8

[ Purge Visitors On Checkout @ true

m Subscribe Point station: |slot:/Services/VisitorIntegrationService/Points/Sub: @ - }

Visitor Type AccessRight Wiegand Format Facility Code Badge Start BadgeEnd  Current Badg R
ﬁ VisitorType and AccessRight mapping

New
O Points Unrestricted Folder
© rublishPoint {ok}
e SubscribePoint - {null} @ def
ﬁ Facets » o -
3 Proxy ext Visitor Proxy Ext
[ Enabled @ true
[ status [fault}
li Fault Cause Input to proxy extension is not a JSON.
(Ml Publish Point  |null Bql Query Builder
== Out - {null} B def Component Chooser
= inl - {null} Component Grid Query Editor
= In2 = {mall} ¥ Directory Ord Chooser
= 03 - [null} ¥

File Ord Chooser

- Ind ILIREE

History Ord Chooser

Orion Ord Chooser

The Points are configured in the VisitorIntegrationService and ready for connection.

Setting up the Abstract MQTT driver network

This procedure explains how to establish the connection between Niagara and Sine application.

Prerequisites:
The Niagara station is licensed for AbstractMQTT driver, and the device certificate (AWSCert.crt) is imported
into Niagara station.

Importing device certificate (AWSCert.crt)

70

Step 1. Expand the station property in Workbench and under the Nav tree menu sidebar and navigate to

Config > Services > Platform Services > CertManagerService.
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Step 2. Click on User key Store tab and select Import button and import the device certificate
(AWSCert.crt) shared by Tridium team.
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Certificate Management
Certificate Managemant for *localhost®
Wser Key Store  System Trust Store  User Trust Store  Allowed Hasts

You have local certificates:

5 Certificate Import S
User Key Store - Y ebgects
B File spaces
Aliga Lottt Lo Usbra | HERIB4E / Fiagarnd. 12 | tridiuen | cetilanagement L]
B0y File Symem = o =
4 D A B ¥ 5 - |
I sne v mmmmnmmq O bty Moduies H

) naotthirgoert  Misgars Enterpnise Sesty

P tidium Waagarsd

. Bookmarks

Frlie pupomes Open
_Cancet |

Files.of Eypees LM Files

Bwew | @wew | [§cothossest | [ osete

=

-p-n‘__‘t'ml IM|

Step 3. Click on the open palette from the Palette menu sidebar and search for AbstractMqttDriver. Drag
the AbstractMqttDriverNetwork component from the AbstractMqttDriver palette to the Drivers
folder (under Config) in the Nav tree.

Step 4. Under the AbstractMqttDriver palette, expand the Devices folder and drag the AwsMqttDevice
component from the palette to the added AbstractMqttDriverNetwork in the Nav tree.

: Station (EntSecurity)  © Config  : Drivers  : AbstractMgttDriverNetwork | AwsMgitDevice #  AXProperty Sheet -

- Nav e Property Sheet

# o CD My Network & AwsMgttDevice (Abstract Mgtt Device)

[Jl Status {ok}

b 6 rdbmsNetwork [ Enabled [ I

b O Ldapetwork [Ml Fault Cause

» [ Health Fail [null]

» @ Alarm Source Info Alarm Source Info

- eAhstraEthttDrwerNetwurl-
3 ;AwquttDevme

™ Franhice
- ° W Poll Frequency Normal

Palette

] [z] E iahstraEtMuttDrivEr

(@l Message ForLWT
e AbstractMgttDriverNetwark

& AbstractMgttDevice

o Devices

b i DefaultMgttDevice [ Clean Session @ false
" s AwsMgttDevice W EnableLwT @ false

= h
} @ GepMattDevice 7 Refresh [™) save

Step 5. Double-click on the added AwsMgqttDevice in the Nav tree to open the AX property Sheet.
Configure the AwsMgqttDevice as follows;.

a. Change Keep Alive to 65535

b. Expand the authenticator in the property sheet and add Broker Endpoint (This needs to
be provided by the Tridium or Sine Team).
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c. Add a unique Client ID in the authenticator. Add the APl Key from

VisitorIntegrationService here due to its uniqueness.

d. IncCertificate Alias and from the drop-down list, select the device certificate
(AWSCert.crt) previously provided and added to the User Key Store in the PlatformServices

* Nav
i 1] o @I«i;hewcow.

f;“ NiagaraNetwork
© Rdbmshetwork
 obixNetwork

@ Photo IDNetwork

6 AbstractMqttDriverNetwork

i AwsMgttDevice
O Graphics
&) Files
Hierarchy
@ History

- Palette
- E] a .-.‘ISI[DHI'ZEEYJ'IDH

M VisitorintegrationService

Q Points

Property Sheet
LJ Health
o Alarm Source Info

(@l Poll Frequency

(Wl Message ForLW T

‘- Clean Session

(M EnableLWT

. TopicForLWT

M QosForLWT

J Retained For LWT

Il Keep Alive

M Connection Timeout

(i Status Message

@ Points

M Connection Lost Waiting Time

‘- Send Enum As
M authenticator
[ Broker Endpoint
(@ Client1D
[ Broker Port
¥4 Callback Router

@ Certificate Alias

rail [24-Feb-22 Y31 PMISI | Ping Fail: Disc...
Alarm Source Info

Normal

@ folse
. false

Fire And Forget (0)

. true

60 seconds [0-65535)

300

Ping Fail: Disconnected from Broker.
Mqtt Client Driver Point Device Ext

00000h 00m 30s|4 [1second-+inf]

@ a6

Aws Mgtt Authenticator

all4B32éxcmwu9-ats.iot.us-east-1.amazonal

sam2k-dev-account-2

[0- 100000]

Mqtt Callback Router

nd4iotthingcert

C Refresh Save

Step 6. Click Save. Right click on AwsMqttDevice, click Actions and then Connect..
If the connection is successful, the Status Message property value shows Connected.

Step 7. Expand AwsMgqttDevice > Points and click on Discover.

Step 8. From the discovered points, pull the subscribe point and publisher point to database and edit the

parameters as follows:

a. For publish point, set Type to MqttStringPublishPoint. Add topic as APIKEY/sine topic-ack.
Here APIKEY is the api key stored in the VisitorintegrationService.

b. For subscribe Point, Type will be MqttStringSubscribePoint. Add topic as APIKEY/sine
topic. Here APIKEY is the api key in the VisitorintegrationService. Please note that the topic

is case sensitive
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File Edit Search Bookmarks Tools Window Manager  Help
4 B 0O- o D [ - B x © 0 B X E Y [ =0y . ] Q
b AwsMattDevice
- Nav Database 2cbjects
# C ) My Hetwork Name Type out Local Point Topic Tuni B
P — @ publshPoint  MottStringPublshPoint - [down,stale) @ def sincTopic
O Tepipservice ) subscriberoint  MquStingSubsaibePaint - [down,stale] sineTopic
O Licensesenvice
© certtanagerService
arintegrationService
- Palette A
W [ B |§ sbstractuotiriver
3 nbstracmatiDriverietwark
o Abst
o
(=0
© abstcmargine
M MewFolder | [mew | #rdit hoiscover | moconcel  @add prwac 0 regm

Step 9. Right click the Proxy Ext of subscribe point and click Actions > Subscribe.

Checking in a visitor

This procedure describes how to check in

Prerequisites:

a visitor.

Login to the Sine dashboard, open the Sine pro-Homepage and create the required Host for Check-In

Successful.

Create Host for Check-In

Step 1.

on Hosts to open the Host dashboard.

4y Activity
() Invitations
@G Reports
My Passes
@ Locations

(R Hosts @

0 Team Hosts

Shammi Agarwal (Honeywell)

& Team

Honeywell ,Bangalore, Campus 2

Navigate to the Sine Pro dashboard. Under the primary menu sidebar on the left-hand side, click

INVITE UNVERIFIED HOSTS ADD HOSTS

3 Hosts
[ Displays
TestHost
3 Hosts
Name Status Email Mobile
Shammi Agarwal Active @ shammi.agarwal@honeywell.com  +918910315797
Apps Spider Man Unverified spider.man@marvelexample.com  +911234567890
“» Core
Sweta Barman Active © sweta.barman@honeywell.com +912334345563
W Workflows
4 Scheduling

Step 2.

74

CREATE A GROUP ~

Click on Add Hosts, enter the Host details as required, and then click on ADD HOST to save the
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new entries.

Add Hosts

First name

Amarnath

Email

Last name

V'

People management

PFlease enter a valid email

Mobile

el -

ADD HOST

Step 3. Go to the Sine ProDashboard and click .
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The Visitor Check-in window opens.

Visitor Check-in

First Name Last Mame

Company (optional)

Email (optional) Mobile (optional)
— "
Site Visitor Type
Honeywell ,Bangalore, Campus 2 Visitor
Host
(TestHost)

Check-in another guest CANCEL MNEXT

Step 4. Complete the form and enter the Visitor's First Name and Last Name as mandatory properties.
Select the visitor type from Visitor Type drop-down list and choose the appropriate Site. Then
click Next.

Step 5. Enter the badge number preceded by b- in Badge Number property (example: b-12345). The
badge number can be an existing number already enrolled in the Enterprise Security application

and available to assign or it can be any arbitrary number between 1 to 5 digits and less than
65535.

Please read carefully and complete the following questions

Badge (Add "b-" before the badge number) *

b-12349

Check-in another guest BACK m
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Step 6. Click on CHECK-IN. A checked-in message will appear under Activity in the Sine Pro dashboard if
the visitor check-in is successful.

4y Activity
Activity [ ACTIVE PASSES
Invitations
D
Reports o
G Q  Search keywords = AnyStatus v © Allsites v
My Passes
@ tocations 1 Checked in v
0 Visit Issued
(2 Hosts isitor ssue
[ Displays Amarendra V G is seeing Shammi Agarwal at Honeywell Bangalore, Campus 2 o
Visitor E, A((ep(e'd by AWS integration on 13 Apr 23 10:27 IST. Issued today at 10:27 v
[E) b-23456
Checked out v
Visitor Issued
Amarendra V G was rejected from seeing Shammi Agarwal at Honeywell Bangalore,
e Oom
ampus 2
A Requested today at 10:26 N
Pps [E] Rejected by AWS integration on 13 Apr ‘23 10:26 IST. B
Visitor Rejected today at 10:26
[F) b-1233456
= Core
Amarendra V G was rejected from seeing Shammi Agarwal at Honeywell ,Bangalore,
W Workflows Campus 2 ©om
. . ©hor 25 108 51 Requested today at 10:24 N
B ted by AWS ints ti 13 A 10:24 I
4 Scheduling Visitor E :i;:smy integration en 3 Apr Rejected today at 1024

Step 7. After check-in, double-click on the checked-in visitor's name in the Activity dashboard to view
notes, badge details, and print passes.

Amarendra V G Visitor § PRINT PASS

is seeing Shammi Agarwal at Honeywell ,Bangalore, Campus 2

Notes  Check-in Forms

1. Badge (Add "b-" before the badge number)
b-23456

Responses last updated today at 10:28

CLOSE SAVE

Step 8. Login to the NiagaraEnterprise Security web application to verify the visitor is successfully
checked in. Navigate to Personnel and click on People. The checked-in visitor is listed under
People.

..|'] L YL

B Rtk we_Lomedan
o i v

The visitor is successfully checked in Enterprise Security.
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Checking a vistor out

Once the visitor checks out they no longer available on the checked-in list. Checking a visitor out may or may
not purge the visitor from the Sine system depending on how you set up the VisitorIntegrationService.

Prerequisites:
Login to Sinepro dashboard.

On theEnterprise Security side, configure the Purge Visitors On Checkout property in the
VisitorIntegrationService for checkout.

Step 1. Navigate to Activity, list of checked in user is displayed.

Step 2. To check out the required user select .71 .
The user details are listed under checked out group.

Checked out «

Wisitor lasued

Amarendra V G sow Shamm Agarwal 2t Honeywall Bangalore, Campus 2 -

Acrepted by B mtrgration o [ Ll
Windbor b 1L hecked cut tocay ot |

Amarendra V G s iejected hom seving Shammi Agareal sl Honeywell  Bangalone, m
Campus 2

Ejecios by SINS mtegraton on 17 Mar

Visitor

Purge Visitors On Checkout enabled

When this property is enabled (set to True) in Workbench, the visitor will be purged from the
NiagaraEnterprise Security system upon being checked out in the Sine dashboard. The system will free up the
associated badges and make them available for reuse.

My Host : IEALLT88R28C3.global.ds.honeywell.com (entTest) . Station (entTest) . Config . Services . VisitorintegrationService / AX Property Sheet ~
0 Points . VisitorintegrationService o SubscribePoint o PublishPaint ; AwsMqgttDevice o PublishPoint 0 Points o Points @
Property Sheet

(@ VisitorintegrationService (Visitor Integration Service)
(@ Status {ok}
(Ml Fault Cause
(M Enabled @ true
(Ml Api Key ££da0871-27a2-4a8a-9béb-£93ae373£9e8

(M Purge Visitors On Checkout

Prerequisites:
The Badge is free from Entsec.

Step 1. Clickon 7 in Sine dashboard to check out the visitor.

Step 2. Go to the NiagaraEnterprise Security web application and navigate Personnel > People. The
visitor is removed from the people list, and their associated badges are free and can be re-

assigned to another visitor/user.
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FBHome || 60 Monitoring *a Personnel Reports | | g System Sewp || E@PhowoID || A Threat Levels

s People Ty Badges |7y AccessRights & Temants ™4, Additional Personnel Data
People

HBIE AE v @)@k
Raj Ritika sine_Comedian

After a check out is complete, audit logs are displayed.

Purge Visitors On Checkout disabled

When this property is(set to False) in Workbench, the visitor will NOT be purged from the NiagaraEnterprise
Security system upon being checked out in the Sine dashboard. Still, their associated badges will be disabled
and cannot be reused.

My Host : IE4LLT88R28C3.global.ds.honeywell.com (entTest) . Station (entTest : Config . Services . VisitorintegrationService / AX Property Sheet ~
(O Points [ Visitorintegrationservice () SubscribePoint () PublishPoint g AwsMgttDevice (@) PublishPoint () Points () Points [x]
Property Sheet

[l VisitorintegrationService (Visitor Integration Service)
[ status ok}
. Fault Cause
[ Enabled ® e
. Api Key ££da0gTl-2Ta2-4a8a-9bEb-£93ae3T3£0%e8
(M Purge Visitors On Checkout ® fals=

Step 1. Clickon 7 in Sine dashboard to check out the visitor.

Step 2. Go to the NiagaraEnterprise Security web application and navigate to Personnel > People. The
visitor still exists under the people list, but their associated badges are disabled and cannot be re-
assigned to another visitor/user.

#8Home | | 60 Monitoring | [IRCECTUUN] Reports | & System Sewp || ElPhotoID || ) Threat Levels n‘(

s People Ty Badges 7y AccessRights @ Tenants . Additional Persannel Data

Raj, Ritika

bl sove | people | &b Add NewPerson | ™ puplicate | @ Assign New Badge | O Enroll New Badge | = Print Badge
Summary Person Access Rights Badges

Assigned

00096 1 26-Bit Wiegand Format (HID-H10301) Raj Ritika

After a check out is complete, audit logs are displayed.

VisitorIntegrationService - Configuration Problem Points and Failures

Topics covered in this section are some common configuration problems and their solutions.
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Error: No access rights in system or No Wiegand formats in system.

4% Error *

Visitor Type Access Right Wiegand Format Facility Code

0 No access rights in system Unrestricted Folder
i 0K | Details
) i gltefre:h | [ﬂch
h

The user receives this error when trying to add a visitor while no access rights or Wiegand formats are set up in
the system.

Solution: First add access rights to the system, then refresh the service. If this issue persists even after you add
an access right and Wiegand format, , invoke the Load Values action.

Error: Visitor Type already exists.

48 Niagara Workbench — | *
File Edit Search Bookmarks Tools Window  Help Q
4 oD O-onfa C i - [

My Host : IEALLT7BMF7C3.global.ds.honeywell.com (sineTest) . Station (sineTest) . Config . Services . VisitorintegrationService / AX Property Sheet -

Property Sheet
(M VisitorintegrationService (Visitor Integration Service)
[ status {ok}
[ Fault Cause
[ Enabled @ e
(W Api Key 32acd29d-bd47-419c-9%e15-5a8e205315¢6
[l Purge Visitors On Checkout @ true
(M Force subscribe interval (In seconds) 60

[i Mqtt Subscribe Point station:|slot:/Drivers/AbstractMgrtDriverNetwork/AwsMgqreDevii il ~ }

Visitor Type Access Right Wiegand Format Facility Code F

[y visitor visitor rights 26-Bit Wiegand Format (HID-H10301) 1

[ VisitorType and AccessRight mapping [ﬁ Contractor contractor accessrights 26-Bit Wiegand Format (HID-H10301) 1

[i Others other access rights 26-Bit Wiegand Format (HID-H10301) 1

» © Points Unrestricted Folder

48 Error Visitor Type Visitor

Access Rights visitor access right.
0 Visitor Type already exists! £ — e Tome

Wiegand Format 2¢-Bit Wiegand Format (HID-H10301)
Facility Code 1

The user receives this error when trying to create a new visitor type while there is already a row in the table
with the same visitor type.
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Solution: To configure the visitor type, edit the previously existing row as visitor type must be unique in this
mapping.

Facility code out of range.

Property Sheet

Ul VeitorintegrationService [Visitor Integration Service
“H Status {0k}
B Fault Cause
"l Enabled P rrue
B Api Key 1incd2 Sd-bdd7-415c-Sel5-5ale2083 ] Scé
M Purge Visitors On Chechout B true
'. Farce subsori T.
" Mgt Subscril friveriietwork/ kusMgreDevic I - P
Visitar Type vigitar -
Access Rights  visitor access rights % Emoe *
'. VisitorType af Wicgand Format 14-Bic Horthern Wisgand Format 8 341518 > 65535 [ - £4538)
Facility Code 231313 [&-65535) )
oK Details
O Points Cancel
ﬂ FublishFomr = Oy
© subscribePaint {rull} @ def
B Facets o m -

The user receives this error when they enter the facility code, which is not in the range with the Wiegand
formats for the badges.

Solution: Provide a facility code that is in range with respect to the Wiegand format you are planning to use.
Access right and Wiegand format are not available in the drop-down list.
Even though the user has added at least one access right and one Wiegand format to the system, those

options are not available in the drop-down list.

Solution: Right-click VisitorIntegrationService, navigate to Actions and Invoke action Load Values and then
refresh the service once.

Visitor Subscribe Proxy Ext Failure:

© Points Unrestricted Folder
© rublishPoint - {ok}
© subscribePoint  {okl @2
[ Facets » © -
3 Proxy Ext Visitor Subscribe Proxy Ext
- Enabled ® tue
[ status [fault}
- Fault Cause Publish Point should have a Non-Null Ord
(Ml Publish Point |null - )
== Qut {ok} @ 2

The Visitor Subscribe Proxy Ext (under Points > SubscriptionPoint > Proxy Ext) is at Fault due to Publish Point
should have a Non-Null Ord:

Solution: In the Publish Point property of the visitor proxy ext, set the value as the ord for the publish point in
the Visitor Integration Service > Points.
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The Visitor Subscribe Proxy Ext Points > Subscribe Point > Proxy Ext is at Fault due to Publish Point type
should be a StringPoint:

© subscribePoint - [null} @ def

(M Facets » 0O-
[4 Proxy Ext Visitor Subscribe Proxy Ext

(@ Enabled @ tru-

(@ status [fault}

(@ Fault Cause Publish Foint type should be a StringPoir

(@ Publish Point  |station:|slot:/Sweta/NumericWritable - - )
= - [null} @ def

Solution: In the Publish Point property of the visitor proxy ext, the ord should be pointing to a String Point.
Change the ord to the publish point provided in the palette for visitorintegration.

The Visitor Subscribe Proxy Ext under (Points > Subscribe Point > Proxy Ext) is at Fault due to Input to
proxy extension is not JSON.

[4 Proxy Ext Visitor Subscribe Proxy Ext
(@ Enabled @ e
(@ status [fault]
. Fault Cause Input to proxy extenbion is not a JSON.

. Publish Point station: |slot:/Services/VisitorIntegrationService/Points/Pub] [l - [ 3

= ut - [null} @ def
= nl - [null}

The Visitor Subscribe Proxy Ext (under Points->SubscriptionPoint->Proxy Ext) is at Fault due to "Input to proxy
extension is not JSON"

Solution: If you get this fault just after the initial setup of visitor integration or when you restart the station,
don't worry about your setup. It is working fine. This is an extra validation. The fault goes away after one
successful check in happens. If this is not your initial setup of visitor integration, check all the input slots for the
Subscribe point. There should be one link mark from the MQTT subscribe point. Apart from that, if there are
any link marks, then this error may occur.
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Chapter 4. Badge management

Making and assigning badges is documented in this guide as well as in the Operator’s Guide.

Each employee requires a badge. In most companies, each visitor also requires a badge. In addition, one or
more badges may be used to initiate a threat level.

Creating a single badge (manual entry)

Manually entering a badge should be done when you need to create only one badge.

Prerequisites:
You are working at the Supervisor station with admin privileges.

Step 1.

Step 2.

Step 3.

Step 4.

Select Personnel > Badges.
The Badges view opens.

Click the Add button (| @ | ).
The Add New Badge view opens.

Complete the properties and click the Save button.
The system saves the badge and opens the Edit Existing Badges view, Summary tab.

Make any additional edits and click theSave button.

Creating multiple badges (batch-create)

You can batch-create a group of badges that can have common values the following properties: status,
format , tenant, issue date, expiration date.

Prerequisites:
You are working at the Supervisor station.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

From the home view, select Personnel > Badges.
The Badges view opens.

Click the Batch Enroll button (|| ).
The Batch Enroll Badges view opens.

Complete the properties that are to be shared for all badges scanned, including Description,
Wiegand Format, Status, Issue Date, Expiration Date, Owner, Tenant, and Enrollment
Reader.

Swipe a set of cards (a batch) one at a time.
As you swipe each card, the card data displays in the New Badges property.

NOTE: If badge numbers do not appear, the corresponding Wiegand format has not been
defined.

To complete the batch-badge creation process, click the Save button.
The system saves the badges, and opens the Edit Badges view. The new badges appear in the
table of badges.

Manually assigning a new badge

This procedure describes how to assign a badge that is not already created (new badge), without using the
reader to scan it in.

Prerequisites:
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You are working at the Supervisor or badge creation station with admin privileges.

Step 1.

Step 2.

Step 3.

Step 4.
Step 5.

Select Personnel.
The People view opens.

Select the person record that the badge is to be assigned to and click the Hyperlink button (|| ).
The edit view for the person opens with the person’s name at the top of the view.

Select the Badges tab and click the Assign New Badge button.

The Add New Badge view opens. This tab is the active tab, by default, when the view initially
opens. The tab includes the following properties to enter or choose information that applies to
the new badge record:

Fill in the properties.

To assign the new badge with the current settings, click the Save button.
The system assigns the badge to the person and displays the new badge in the edit existing
badge view.

Enrolling from a reader to assign a new badge

This procedure describes how to assign a badge that is not already created (a new badge), using a reader to

scan it in.

Prerequisites:
You are working at the Supervisor station.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.
Step 7.

Select Personnel.

The People view opens.

Select the personnel record that the badge is to be assigned to and click the Hyperlink button (
al )

The Edit Person view opens with the person name at the top of the view.

Select theBadges tab and click the Enroll New Badge button.

The Enroll New Badge view opens.

Complete the properties.

NOTE: You have to assign an Enrollment Reader before you can scan a badge to complete some

of the properties.

Scan the badge at the designated enrollment reader.
The badge Id number appears in the Scanned Badge property and one or more format options
appear in the format pane.

NOTE: If the badge number does not appear, the corresponding Wiegand format has not been
defined.

Click the Save button.

Click the OK button to assign the badge.
The badge is assigned to the person and the new badge displays in the Edit Existing Badge view.

Assigning an existing badge

A badge is required at most facilities to enter and exit buildings. This procedure describes how to assign a
badge that is already created (existing badge), without using the reader to scan it in.

Prerequisites:

You are working at the Supervisor station with admin privileges. The badge to assign to the person exists in
the database. You just created the new person record and are continuing with setting up the new person or
you are editing an existing person and have already double-clicked the person’s name in the People view.

84

March 17, 2025



Niagara Enterprise Security Facility Manager's Guide Badge management

Step 1. Click the Badges tab.
The Badges discovery view opens.

Step 2. Click the Assign Mode button (| 5 ).
The system populates the Unassigned pane with all available unassigned badges.

Step 3. Select the badge to assign to the person and click the Assign button (| ).
The system assigns the badge to the person by moving it from the Unassigned pane to the Newly
Assigned pane.

Step 4. To update the person'’s record in the database, click the Save button at the top of the view.
The Summary tab opens with a summary of the properties you just updated.

Capturing a photo and associating it with a person

You may capture a photo using a portrait camera connected to the Photo ID station, or use any photo taken by
any camera and located anywhere as long as it is stored as a .jpg or .png file.

Prerequisites:
The browser used to run the system must be running in the Photo ID station to which the USB portrait camera
is connected.

Step 1. From the home view, click Personnel > People, double-click a person’s row in the table, and click
the Person tab.
The Person view opens.

o Monitoring fa Personnel D Reports

£+ Home

*s| people [y Badges g AccessRights & Tenants

Anderson, Bradley
Save || 4t People || g AddNew Person || [y Duplicate

Person

Last Name Anderson
First Mame |Bradley
Middle Initial

Employee Id

Department |Sales »
Person Type »
Tenant g ] INnne »

Supervisor fFalse

Trace Card T

PIM JELTTITTTY

PIM
Conf

Portrait == [

Step 2. At the bottom of the view, click the capture icon (&3 ).
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NOTE: If you do not have a capture button, check for the native badge design device added
under the photo ID network that needs to be added to the station.

A waiting-for-capture window opens.

Step 3. If you have more than one Photo ID station, the software asks you which Photo ID station you are
using.

Step 4. Select the station and click OK.
The Capture Image window opens.

¥ Capture Image

| Capture

Step 5. Focus the image and click the Capture button.
The Next Step window opens.

A

Newt Stepd

Step 6. To crop the photo, click OK.
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The crop tool opens.

Step 7. Enter the aspect ratio (width: height) from the template, adjust the crop box and click the Save
button.
The Print Preview window opens.

H Puind preview

GL-DODEBE@E o

Deidre

Reynolds

Doctor
St. Marigolds Clinic

The system places the photo in the persons portrait section within the database.

Importing a photo

This procedure allows you to use an existing photo on a badge.

Prerequisites:
Before you can import a photo, the person must exist in the database.

Step 1. From the home view, click Personnel > People, double-click a person’s row in the table, and click
the Person tab.
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The Person view opens.

4+ Home

Anderson, Bradley

da” Monitoring

s| people = [y Badges

Niagara Enterprise Security Facility Manager's Guide

fs Personnel

if Access Rights

[} Reports

@ Tenants

E Save 9 People

QJ., Add New Person

% Duplicate

Person

Last Name |.ﬁ.ndersun

First MName |Bra-:||e~;.-'

Middle Initial |

Employee Id |

Department |Sales

Person Type |

Tenant @lNDne
Supervisor

Trace Card

PIM

NOTE: If file open icon is not available, create and save the person first.

Step 2. Click the File Open icon ((fi ), browse for the photo file and click the Save button.

Cropping a photo

Portrait F‘E Py

JH |llliiiil

Use this procedure to crop a captured or uploaded photo.

Step 1. From the home view, click Personnel > Person.
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The Person view opens.

{2+ Home

fs| people = [y Badges 5§ AccessRights & Tenants

o Moenitoring f» Personnel D Reports

Reynolds, Diedre
Save ‘i} People Q} Add MNew Person % Duplicate I:

Person

Last Mame |RE}-‘HDII:|S

First Mame |DEidrE

Middle Initial |

Employee Id |

Department |

Person Type |

Tenant P INnne

Supervisor
Trace Card Trace OFF %

PIM {number anly ) |uuuu

PIN

Confirm PIM: ||---|-||

Portrait

Step 2. Click the Crop Image icon ([, ).
The Choose an Image Ratio Source.... window opens.

Choose an Image Ratio Source....

® @ Image Ratio 3:4 {Template ABC Company Badge. Employes Phota)
O <> Image Ratio 314 (Default)
# < Freehand

| ok || cancel |
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Step 3. Choose one of the following :

* Image Ratio width: height (template name) where:
e width is the width as defined by the template.
* height is the height as defined by the template.
* templatename is the name of the template.

* Image Ratio width: height (default) where:
¢ width is the default width.
* height is the default height.

e Freehand lets you use the freehand tool alone to crop the image.

NOTE: Although this may seem the easiest way to crop the photo, it may result in a
distorted image. The best option is to use the aspect ratio as defined in the template.

The photo capture window opens with a cropping box set to the largest size possible.

Step 4. Grab any corner or edge and drag the cropping box smaller, then click and drag the center of the
cropping box to move it to the desired position.

Step 5. When the cropping box is centered over the face, click the Save button.
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The photo is cropped to the smaller size while maintaining the aspect ratio.

Cropping Image...

| ok || cancel |

Step 6. Click OK and click the Save button.

Printing badges

This procedure explains how to print one badge or a group of badges.

Prerequisites:

Badge management

To print a dual-sided badge you follow the same procedure. A dual-sided template and printer capable of
printing on both sides are required.

Step 1. Beginning from the home view, click Personnel > Badges.

Step 2. Select the badge(s) to print, right-click and click Print Badge. You can also click the Print Badge

button.
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The action drop-down list opens.

dd” Monitoring s Personnel D Feports Photo 1D

{b Home @ System Setup

*» people @[y Badges ’§ Access Rights & Tenants ™ Additional Personnel Data

DescHptdon

€, Hyperlink
SUMmary ]
[f'j Show Readers

£ Show Access Hiskory
) Show Excpirations

> Delets
ik Edit

B print Badge

0000000001 234565 1] HO 55-Bit “Wiegand

The Print Preview view opens.

t® Print preview

& O - |00 @ @ Cos

712912011 2:27: M

54326?‘?\

Sales

NOTE: When more than one badge is selected, you can use the Print Badge button to skip the
Print Preview and print all selected badges in one print operation.

Step 3. Click the print icon ( & ).
The badge prints.
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Chapter 5. Threat-level management

Threat Level management is a licensed feature that provides a way to quickly initiate broad-scale changes to
building access based on one or more predefined operational levels (threat Levels) and facility spaces (threat
level groups).

Authorized persons use the application interface, an activation badge, or a hardware device to activate the
threat level in response to a situation that requires a change to the scheduled access requirements for one or
more specific facility areas.

Configuring a system for threat levels involves these primary tasks:

e Setting up threat levels and threat level groups

* Setting up access rights, doors and readers to respond to threat levels

* Assigning access rights, readers, door strikes and activation badges to threat level groups

Threat levels
Threat levels and threat level groups form the core of threat level management. The procedures outlined in the
related topics require an understanding of how threat levels work and involve configuring system properties.

By default, the system provides a set (or range) of active threat levels, which are available as enumerated
options.

Figure 17. Activate Threat Level window

Activate Threat Level

\Lockdown[10]  ~)
Lockdown [10
Restricked [9]
Emergency Responders [3]
Unlock. [7]
Mormal [5]

Low [0]

Assuming you have appropriate administrative privileges, you may rename or supplement this set of threat
levels. Each threat level definition includes a number within a range up to a maximum of 255. This number
indicates relative degrees of building access.

The default level for normal operation is [5]. This relaxes the restrictions in certain cases, such as when an
evacuation is needed, or emergency response teams need general access.

Generally, each successively higher number within the range is more restrictive, so that the higher the threat
level, the higher the access privilege that is required to enter the building.

NOTE: If the Access Right is associated with NAC Readers, the threat level changes would be automatically
replicated to NAC Controllers. This replication occurs through the NAC Threat Level Replication Job.

Threat level groups
Threat level groups apply and manage active threat levels in a facility’s physical space.

If you intend each access right, card reader, and door strike to be affected by threat levels, configure each with
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a threat level group. Without a threat level group assigned, an access right or device cannot respond to or
interact with threat levels. Only those access rights and devices with a threat level group assigned are threat-
level aware.

To assign a threat level to a person, you assign an access right with an associated threat level. By default, the

threat level assigned to the access right is also assigned to the person. You may change this and directly assign
a threat level to a person.

Threat level group hierarchy
You can arrange threat level groups in a parent-child hierarchy that makes sense for your facility.

Figure 18. Threat Level Group parent, child hierarchy

&d” Monitoring ;‘é'? Controller Setup ik Threat Levels f ] IC](:

& Personnel

A Threat Level Groups  fi Threat Level Setup

SEE alls)(B]e 2 #FEE)@03E
AN 1)
Acme Master Threat Level Group  /Acme Master Thr}:al.'l‘_‘érel Groupf 2 Low [0] Mormal [5]
Bldg.1-Threat Level Group /Acme Master Threat Level Group/Bldg.1-Threat Level Group/ Low [0] Mormal [5]
Bldg.2-Threat Level Group /Acme Master Threat Level Group/Bldg.2-Threat Level Group/ Low [0] Mormal [5]
£ >

1. Parent group
2. Child groups

Changing the parent threat level group’s active threat level automatically changes the threat level associated
with the its child threat level groups. You may change the active threat level assigned to the child without
affecting the active threat level assigned to the parent or other children under the parent.

Threat levels and people

Threat level assignment, for people, is initially accomplished using access rights. When a person is assigned an
access right, the Default Assigned Threat Level on that access right becomes the assigned threat level
associated with the person. While this automates the initial assignment of threat levels to people, you can
specifically change a person’s threat level without changing the person'’s assigned access right.

You would use this method of assigning threat levels if you have a large number of people assigned to an
access right, but only certain people assigned should be granted access in special situations.

What to do when the threat has passed

The threat level does not change automatically when the condition clears. You can override a thread level
through the web Ul, a hardware input, or by u sing a threat-level card. These methods return the threat level to
the level designated for normal conditions.
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Setting up threat levels

The system comes with three default threat levels in a range from 0 to 10: High [10], Normal [5], and Low [O].
You may change and add to these default threat levels up to a maximum of 255 levels. When setting up threat
levels, consider leaving gaps in the numeric assignment so that you can insert levels later if needed.

Prerequisites:
You must have sufficient administrative privileges. For systems with a Supervisor, after you join a controller to

the Supervisor, you must add all threat level groups at the Supervisor. Threat levels for systems without a
Supervisor may be configured at a controller.

Step 1. From the main menu, expand or click Threat Levels > Threat Level Setup.
The Threat Level Setup view opens.

A\ Threat Level Groupz | J\ Threat Level Setup

adve

Threat Level Setup

Activation Initiated Alert Alarm Source Info »
Activation Failure Alert  Alarm Source Info »
Activation Complete Alert Alarm Source Info »
Activation Mismatch AlertAlarm Source Info »

3 || (=

Threat Level Range
10 High
5 Mormal
] Low

activationFailureAlarm Alarm Source Info 3

the example shows an expanded list of escalating threat levels.

Step 2. Start by defining the situations that require modifications to the building’s access or that will
trigger events, and order them from least to most severe.
Remember to leave gaps in the numeric assignment so that you can insert additional levels later.

Step 3. Do one of the following:

¢ To edit one of the default levels, select the level and click the Edit button ( 5 )).

¢ To add levels, click the Add button ( @ ).
The Edit Display or Add window opens.

Step 4. Pick a number, create a name and click Ok.
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Adding (or editing) a threat level group

A threat level group anticipates what to do in a specific type of emergency. For example, by invoking a threat
level group when a child is reported lost, all doors may be automatically locked. You configure the activation
method for the various levels: hardware inputs that may trigger various levels, hardware outputs that may be
triggered at various levels, and access rights that are modified when the threat level changes. Specific
activation cards (badges) may be associated with a threat level group to activate predetermined threat levels.

Prerequisites:

You are working in the Supervisor station. The access rights and badge(s) to assign to parent and child threat
level groups already exist in the system.

Step 1. From the main menu, click System Setup > Threat Levels.
The Threat Level Groups view opens.

g‘fs‘? Controller Setup A\ Threat Levels r ] Idgdr (j

framework

&
Acme Master Threat Level Group JAcme Master Threat Level Group/ Law [0] Narmal [5]
Bldg.1-Threat Level Group JAcme Master Threat Level Group/Bldg.1-Threat Level Group/ Laow [0] Naormal [5]
Bldg.2-Threat Level Group JAcme Master Threat Level Group/Bldg.2-Threat Level Group/ Low [0] Normal [5]
£ >

Step 2. To create a new group, click the Add button (| o).

Threat level groups may be related to one another as parent is to child. Child threat level groups
inherit the attributes configured for the parent.

Step 3. Do one of the following:

* To create a parent threat level group, give the group a Display Name, but leave Parent
blank.

* To create a child group, give it a Display Name and identify its Parent.
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The Add New Threat Level Group view opens.

&d” Monitoring ﬁ Personnel ﬁ'} Controller Setup 4k Threat Levels

i\ Threat Level Groups 4\ Threat Level Setup

K save | [} Threat Level Groups

Display Name |Threat Level Group2 |

Parent & |Nc-ne »
Summary Threat Level Group Activation Badges AccessRights | & | & | A | 2 & | 2
Active Level Low [0]

Default Access Right Threat Le'.rel
Active Ordinal 0

Tenant P |None »

The illustration shows the view when adding a new threat level group, and when editing an
existing threat level group.

Step 4. If you are editing multiple parent and child threat level groups, clicking the Show Top Level button
(| g ) filters the table to display only parent threat level groups.

Step 5. To remove this filter, click the Filter button (& )
The Filter window opens.

|‘1-’n Must Include s o Case

[ | Threat Level Group Name it

|% ||Mu5t Include Vl W] case

Sensitive

| Active Level |

> |

Default Access Right Threat Level

DTE'IEI‘I'I Name |‘1-’n Must Include “ Ml case
Sensitive

Step 6. To see all threat level groups, clear the Path property.

Step 7. To assign access rights to a parent or child group, click the Access Rights tab; to discover
unassigned rights, click the Assign Mode button (|5 ); select the right in the Unassigned pane
and click the Assign button ([ g/ ).

Step 8. To assign one or more badges, which staff can use to activate the group, click the Activation
Badges tab; discover the badges in the system; select one or more badges and click the Assign
button (|5 ).

Step 9. To configure the system to pass threat level group information to one or more remote stations,
click the Remote Stations tab; discover the remote station(s) to receive the threat level group
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information; and assign the remote station(s) to the threat level group.
If a remote controller has an access right that is already assigned to the threat level group, the
system notifies the remote controller of the threat level change.

Step10. To confirm the configuration, click Save and review the Summary tab.

Assigning a remote station to a threat level group

If a remote controller uses an access right that has been configured with a threat level group, the replication
process propagates the threat level group to the remote station. If the remote controller access right is not
configured with a threat level group, you must assign the remote station to the threat level group. This ensures
that the system passes threat level group information to the remote station.

Prerequisites:
This procedure assumes you are working in the Supervisor station.

Step 1. From the main menu click Threat Levels.

Step 2. Double-click an existing threat level group.
The threat level group view opens.

Step 3. Click the Remote Stations tab.
The Remote Stations tab opens.

ﬂ Home & Monitoring ﬁ Personnel Reports gég"? System Sefup Photo ID A\ Threat Levels n lag.@“@

Av Threat Level Groups /i Threat Level Setup

Save || &) Threat Level Groups || & Activate Threat Level || 2, Retrieve Active Status || (B Add Child

Summary Threat Level Group Activation Badges Access Rights Remote Stations

Newly Assigned

@ FDE

A

Unassigned

B

entSecurity801 {down,alarm,unackedalarm} /Drivers/NiagaraMetwork/entSecurityB01

0
L1

Step 4. Click the Assign Mode button (|5 ).
The system discovers and displays the available (unassigned) remote stations.

Step 5. Select the station and click the Assign button (| |).

Directly assigning a threat level to a person

Once you specify a specific threat level, the person’s threat level is no longer linked to the person’s access right
and will not change if the threat level group defined in the access right changes.

Prerequisites:
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The person to whom you are directly assigning a threat level exists in the system database.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

From the main menu click Personnel.
The People view opens.

Double-click the person row in the table or select the person to edit and click the Hyperlink
button ([ @ ).
The person'’s view opens.

Click the Access Rights tab.
The Access Rights tab displays the assigned rights.

| save | [ People || & Add New Person || [y Duplicate || [ Assign New Badge || [J Enroll New Badge

Summary Person Access Rights Badges

Assigned

omE@ ®EE

Access Right Name / Schedule Name Integration Name Tenant Name Threat Level Group Name Start Date End Date Assigned Threat Level

Daytime working hours Boolean Schedule B Company Threat Level Groupl --Default--
Summary
] Hyperlink
@ Unassign

w, Change Assignment Properties

.

Select one or more access rights, right-click the selection, and click Change Assignment
Properties.
The Change Assignment Properties window opens.

vel ) [02 v Haug wHz01s  [[oe w][07 v][am v]eDT

vel ) [02 w Haug wHz01s |08 w07 w][am w]eDT

Assigned Threat Level EE TS
I

Select a threat level and click Ok.

This assignment overrides and breaks the link to an assigned access right’s default threat level. A
person may have more than one access right assigned. You can edit each access right to directly
assign the threat level.

Assigning access rights to threat level groups

Assigning access rights to threat level groups creates the link between the threat level group and each access
right, such that, the access right threat level defaults to the threat level of the threat level group. This
procedure is not required if your access rights are configured with threat levels.

Prerequisites:
If your system is configured with a Supervisor, this operation must be done at the Supervisor station.

Step 1.

From the main menu, expand or navigate to Threat Levels > Threat Level Group and double-click
a threat level row in the table.
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Step 2. Click the Access Rights tab.

Step 3. Click the Assign Mode button (| 5 ).
The system discovers all unassigned access rights. You may assign an access right to only one
threat level group. If an access right is already assigned to a threat level group, and you assign it
to a different threat level group, the system removes the access right from the previously-
assigned group.

Step 4. Select an access right, and click the Assign button (| & ).
The access right is now assigned to the threat level group.

Threat level response

Access rights, doors and readers must be prepared to respond when a threat level is activated. The
information in these topics involves configuring system properties on access rights, door strikes and readers.

When setting up access rights, one must determine what type of person will need access in various situations,
and what type of person should have access inhibited in these situations. For example, contract workers may
have their access to a lab area denied if there is a chemical spill in the area. If the access right assigned to a
contract worker has a default threat level set at normal [5], and the threat level is set to 10, the system denies
access to the contract worker, but it allows access to everyone whose access right is configured with a threat
level of 10 or higher.

The threat level for the area could be further increased to 15. This would restrict access to everyone with an
access right and threat level of 14 and below. It would allow access to everyone with an access right and threat
level of 15 and higher.

Inhibiting those assigned an access right with a threat level below the active threat level, while granting access
to those assigned an access right with a threat level above the active threat level represents the normal mode
of threat level operation for an access right. An access right may also be set to be active only at a specific
threat level, or to be active in reverse mode. In this mode, the meaning of the scale flips. Reverse mode grants
access when the assigned access right’s threat level is below the active threat level, and prohibits access with
the access right’s threat level is above the active threat level. You may use this type of action for non-internal
emergency responders that need access for certain situations (Fire fighters need access to the fire. Normal
workers need to flee the fire.)

Access rights are based on a schedule that specifies where and when a person may enter a building. To
support threat levels, each access right should also be configured with a unique threat level group. When a
person attempts to gain access using an access right configured with a threat level group, the system
compares the currently active threat level with the threat level contained in access right’s threat level group. If
the threat level group validates, the system authorizes the person to enter the building.

Adding a threat level group to an access right

Associating a threat level group with an access right is how you configure the system to assign threat level
groups to individual people.

Step 1. From the main menu expand or navigate to Personnel > Access Rights and either create a new
access right, or double-click an existing access right.

Step 2. If you are editing an existing access right, click the Access Right tab.

Step 3. Click the chevron to the right of the Threat Level Group property.
A Ref Chooser opens with the list of available threat level groups.

Step 4. Select a threat level group and click Ok.

Step 5. To update the database, click the Save button at the top of the view.
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Directly assigning a threat level to an access right

This procedure makes it possible to define a unique threat level for an access right independently of the threat
level defined in the threat level group.

Step 1.

Step 2.

From the main menu click Personnel > Access Rights >, double-click an access right in the table
and click the Access Right tab.
The access right view opens with the Access Right tab selected.

Summary Access Right People Readers Floors

Access Right Name |accesa Right1 |
Schedule | Boolean Schedule »
MNiagara Integration ID 4 [None »
Tenant P |I'~Iune »
Threat Level Group i I'Ihreat Level Group » a8
Threat Level Operation | Normal v|

Default Assigned Threat Level [ E15)] V|

Description

Select an assigned threat level other than --Default--.

When a threat level group is associated with an access right, the system determines the actual
threat level based upon how you configure the Default Assigned Threat Level on the access
right. If you leave this property set to ——Default--, the system uses the Default Access Right
Threat Level as defined for the threat level group. This is convenient. It means that to change
the threat level for all access rights, all you have to do is change the Default Access Right
Threat Level on the threat level group. To break this threat-level-group-to-access-right link you
may change the Default Assigned Threat Level from --Default-- to a specific threat level.

Configuring a threat level on a door strike

The way that a threat level affects a door depends on the way that you configure the door’s strike.

Prerequisites:
You are working in the controller station that manages the door.

Step 1.

From the main menu, click Controller Setup > Remote Devices > Remote Modules > Remote
Module Setup and double-click the door device (module), click the door name, and click the Strike
tab.
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Step 2.

Step 3.

The Module Setup view opens to the Strike tab.

Strike  Sensor  Exit Request
Locked State
Status Locked {fault}
Auto Relock |Rel-m:k. On Door Open V|
Schedule Operation |Normal v |
Unlock Schedule |Hune »
Override Schedule INone schedule.override.chooser.label
Access Unlock Time m 5 [1sec - 59mins]
Log Exit Requests  |None v|
Log Schedule ﬁ.ﬂti'.l'it‘f
Threat Level Group /i |None »
Door Lock Output  |Relay Output 1 /|

Configure the Schedule Lockdown Threat Level property to something other than None.
The system keeps the door locked as long as the active threat level is at or above the level
specified here.

NOTE: This value must be greater than the value of the Unlock Threat Level property. If not, a
warning message displays next to the property when you try to save the changes.

Configure the Unlock Threat Level property to something other than None and to a lower
threat level than that configured for Schedule Lockdown Threat Level.

Typically, the Unlock Threat Level would be lower than the level defined for normal operation
(less than 5 in our example). The system keeps the door unlocked, no matter what the associated
schedule state is.

NOTE: This value must be less than the value of the Schedule Lockdown Threat Level
property. If not, a warning message displays next to the property when you try to save the
changes.

Configuring a threat level for a reader

Assuming your reader has the required features, at a normal threat level a reader can require a reader-only
card swipe for validation. However, at a higher active threat level, a reader may require a card swipe and the
entry of a PIN to provide valid access.

Prerequisites:
You are working in the controller station that manages the reader.

Step 1.

Step 2.

Step 3.
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From the main menu, click Controller Setup > Remote Devices > Remote Modules > Remote
Module Setup and double-click the remote module that supports the door device, click the Doors
tab, click the door name, and click the Strike tab.

The Module Setup view opens to the Strike tab.

Configure the Elevated Threat Level property to something other than None.
Setting this value to None causes the system to ignore the threat level.

Configure the Elevated Threat Reader Config property.
This tells the system what to enable when the active threat level matches or exceeds the
Elevated Threat Level value.
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Activation level input

On a controller (not a Supervisor) the Manage Devices button adds a boolean activation level input to a
particular threat level group. This In property selects a controller Digital Input (DI) or Supervised Digital Input
(SDI) as the initiating event. The Active Threat Level property defines what active level the threat level
group changes to when the input is active.

The input triggers a specific threat level. You would set up one input for a lockdown, and another input for the
all clear.

Figure 19. Activation Level Input tab

Acme Enterprise Master Threat Level Group/Bldg.2-Threat Level Group
| || ‘@ Threat Level Groups || & Activate Threat Level || @sztrieve Active Status || Manage Devices

Activation Level Input

Out Active {ok}

Active Threat Level | Emergency Responders [5] |

In @ |Base Reader Module. Sdi6 » B|
Inactive State open W%

For example, imagine a duress or panic device located near a reception desk. When someone activates the
device, it sets the threat level of the associated threat level group to a high level, such as 10 or higher. An
activation badge, Boolean input, or command from the console can be used to reset the threat level group
back to normal.

Activation level output

On a controller (not a Supervisor) adding a Boolean activation level output to a particular threat level group
assigns a controller relay to the Relay Out property. The Manage Devices button adds this tab.

When the active level matches or exceeds the Assigned Threat Level property, the relay responds
according to the Threat Level Operation property. If the Out property is active, the system energizes the
relay.

For example, initiating a high threat for a threat level group can activate a relay output, which is connected to
an alarm dialer. This causes the dialer to initiate a call to a central monitoring station.

Access rights and activation badges assigned to threat level groups

Assigning access rights and components to threat level groups uses a discovery process, which makes it
possible to assign multiples at a time.

Activation badge

Rather than grant access, an activation badge activates a specific threat level for a specific threat level group.
An activation badge uses access rights to implement an active threat level at the desired access points. Access
rights are assigned to people. There are two ways to create an activation badge.

e Create a fictitious threat level person; assign that person access rights that allow the activation badge to
work; then assign all activation badges to that person. The system recognizes these badges as activation
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badges for activating the designated threat level at the access points associated with the threat level
group. Activation badges do not provide access to the door associated with the reader.
¢ Assign an access right to a real person with sufficient default levels to allow the person to initiate a threat
level.
When you assign an access right to a person for the purpose of creating an activation badge, be aware of the
access right’s threat level. A person with an access right configured for a threat level of three [3] cannot use
their badge to change an active threat level that is a level four [4] or higher. A good practice may be to create
a threat level just for the person with the activation badge and set its Default Access Right Threat Level
property to the highest threat level.

Creating an activation badge

You create an activation badge the same way you create any other badge, but, instead of providing access to a
facility, you configure this badge to activate one specific threat level for one specific threat level group.

Prerequisites:

The person (fictitious or real) exists with an access right assignment for a valid schedule. All readers for which
this badge is to activate the threat level exist. If your system is configured with a Supervisor, you are currently
working in the Supervisor station.

NOTE: To make it easier to set up the activation badges, you may want to create a threat level person and
assign all activation badges to that person.

Step 1. From the main menu click Personnel > Badges, and click the Add button ([ & |).
The Add New Badge view opens to the Badges tab.

Step 2. Configure the basic badge properties.

Step 3. For Owner, enter the person with the access right assignment that is valid for activating a threat
level on desired readers.

Step 4. When you complete configuring the badge, click the Save button.

Step 5. Navigate to Threat Levels, double-click the threat level group to assign to the badge, and click the
Activation Badges tab.
The Activation Badges tab opens.

Step 6. Click the Assign Mode button (|5 ).
The system discovers all unassigned badges. The activation badge may be assigned to only one
threat level group. Once it is assigned to a group, it is not available from the Unassigned pane to
be assigned to any other badge in the Activation Badges view.

Step 7. Select the activation badge and click the Assign button (| o).
The system assigns the badge to the threat level group.

Assigning a threat level to an activation badge

After you have assigned an activation badge to a threat level group, you need to assign the threat level that
the activation badge will initiate.

Prerequisites:

NOTE: Threat level jobs, such as Activate Threat Level and Retrieve Active Status, cannot be canceled from
the browser once they start.

Step 1. Navigate to System Setup > Threat Levels, double-click the threat level group, and click the
Activation Badges tab.
The Activation Badges tab opens.

Step 2. Select and right-click on one or more listings in the displayed table.

Step 3. Click Change Assignment Properties from the popup menu.
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The Change Assignment Properties window opens.

Activation Badges Access Righ S
Change Assignment Properties

Active Threat Level [0 v]
=

34-Bit Morthern Wizgand Format Active N Clair

Step 4. Choose the desired threat level from the Active Threat Level drop-down list and click the Ok
button.
The system changes the active threat level for the badge.
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Chapter 6. Reports

Reports provide information about the data stored in the station database. The system provides a set of pre-
configured (default) reports and the ability to create custom reports. You can save custom-configured reports
as well as schedule any report for automatic generation and email forwarding.

Default reports are optimized for quick processing. These reports return only one row for the data in each
column. If a report request can return multiple answers in any one column, you see only data for the first
answer found.

Full reports return all data, but are much slower to compile. The data in any one column can display multiple,
semi-colon-separated results.

For example, an optimized report on people with a column showing their assigned badges only returns one
badge per person. A full report of the same data shows every card assigned to each individual.

History reports
The default history reports include:

* The Access History report displays a table of all access activity.

* The Alarm History report provides a time-stamped table with a row for each alarm that includes: timestamp,
description, acknowledgment, source, credential number and owner name.

* The Intrusion History report displays a time-stamped table that lists each time the intrusion zone was armed
and disarmed.

* The Attendance History report displays a table of badge transactions with arrival and departure times.
* The Audit History report displays a table of records of all system operations.
* The Log History report displays a table of all log entries.

Hardware reports
The default hardware reports include:

* Doors report lists all doors.

* Readers report lists all readers connected to the network.
* Inputs report lists digital inputs that are on the network.

* Outputs report lists all digital outputs on your network.

* Elevator report lists all elevators.

* Modules report lists all hardware modules on the network.
* BACnet report lists all BACnet points in the system.

Miscellaneous reports
This set of default reports includes the following:

® Person Access Right report.
* Person Reader report.
® Access Right Reader report shows the access rights and their assigned readers.

* Personnel Changes report.

Custom reports
You can configure a custom report to appear anywhere in the navigation path and schedule the emailing of a
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report at a time you designate. Emails are initiated by a transition from false to true using a Boolean Schedule.

Viewing a report
A default report is one that is available under the Reports menu in the navigation tree. Custom reports may
appear anywhere in the menu hierarchy.

Step 1. Do one of the following:

* To view a default report, from the Home view, click Reports, and click a report name, such
as Alarm History, Audit History, etc.

* To view a custom report, navigate to the report and click its name in the menu structure.
Hardware Reports and Miscellaneous Reports are further organized into report sub-groups.
The report table opens.

1 Home || & Monitoring | | R P 1 B Reports @ System Setup Photo ID A\ Threat Levels

“H ACCESS 4 Access History <ts Alarm History <. [Intrusion History . Attendance History < Audit History < Log History #% Hardware Reports

& r || B ® 2| G| L 4 || P |rage of 27 Page Size
Timestamp * Log Name Severity Message Exception
07-Aug-18 5:05 PM IST crypto 1000 Could not create socket, Cause is: Connection timed out: connect
07-Aug-18 5:05 PM IST crypto 1000 Could not create socket, Cause is: Connection timed out: connect
07-Aug-18 S:04 PM IST niagaraDriver 1000 NiagaraMetwork error handling new fox server connection javax.baja.sys.DuplicateSlotException: Slot
07-Aug-18 S:04 PM IST niagaraDriver 200 Creating station for connection "entSecurity”
07-Aug-18 5:00 PM IST crypto 1000 Could not create socket, Cause is: Connection timed out: connect
07-Aug-18 4:59 PM IST crypto 1000 Could not create socket, Cause is: Connection timed out: connect
07-Aug-18 4:59 PM IST sys 200 Saved C:ProgramDatali 4.5 ridium 2.4.2 i ecurityconfig.bog (737ms)
07-Aug-18 4:59 PM IST orion 800 end checkpeint on MySQLDatabase (rdbMySQL:MySQLDatabase)
07-Aug-18 4:59 PM IST orion 200 bagin checkpoint on MySQLDatabase {rdbMySQL:MySQLDatabass)
07-Aug-18 4:59 PM IST bax 1000 q admin @ https://0 1 (63433) com.tridium.box.ServerSessionException: €

The example is of the Log History report table.
Step 2. If the report contains more than one page, navigate to the additional pages.

Step 3. To filter the report, click the Filter button (= ).
The Filter window opens.

. Timestamp Today | %

Ll Log Name I% Must Include % | Case Sensitive
O Severity min Iﬂ max (0

Ll Message I% Must Include s | | Case Sensitive
[ Exception [ Must Include | ] Case Sensitive

The screen capture above is for log history. Each report provides a different set of filter criteria.
Step 4. Select and define the filter criteria and click Ok.

Step 5. To print the report, click the Export button (| ), select PDF for File Type and click Ok.
The system creates a PDF, which you can use to create a hard copy.
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Step 6. If the report contains a large number of records, only a few of which are needed, click the Purge

Config button.
The Purge Config window opens.

Capacity 2000 % | [1- 2147483648]
Full Policy

Step 7. Define the Capacity and Full Policy and click Ok.
The system removes the records that exceed the defined capacity from the database.

Adding a custom report

You create a custom report by basing it on an existing default or custom report. The report you create may
appear anywhere in the system menu structure.

Step 1. Do one of the following:
* To base your report on a default report, from the Home view, click Reports, and click a
report name.
* To base the new report on a custom report, navigate to the report in the menu structure.
The report table opens.

Step 2. Click the filter button % .
The Filter window opens.

NOTE: Any filters that are active when you add the report become read-only for the new custom
report. For example, if you add a report that is filtered using the Timestamp property, you cannot
then change the Timestamp property value. You can, however, change other properties in the
Filter window to further filter the custom report.

Step 3. With the filtered report information displaying, click on the Manage Reports button w .
The Manage Reports window opens.

How would you like to Manage Reports?
OQ add

:_\' 5 Edit

:_\'@ Deleta

O | Schedule Emailed Report

Step 4. To add a new report, choose the Add option and click Ok .
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Step 6.
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The Add Report window opens.

MName | |

Mavigation Path | None v

Icon | |

Give the report a name (Name), choose a location to display the report on the main menu
(Navigation Path), define an icon to appear next to the report name (Icon), and enter an integer
(Index), which determines where the report appears (left to right) in the navigation path.

NOTE: If you choose None for Navigation Path, the report name does not appear in the menu
but you still have access to it from the Manage Reports windows (for example, View Report, Edit
Report, or other).

In the Add Report window, click the Ok button.
The new report menu item displays in the selected menu navigation path.

Editing a custom report

Editing an existing report is similar to creating it in the first place.

Step 1.
Step 2.

Step 3.

Step 4.
Step 5.

Navigate to the report table in the system'’s menu structure.

Click on the Manage Reports button (|| ).
The Manage Reports window opens.

Choose the Edit option and click Ok.
The Edit Report window opens.

Edit a property and click Ok.

Select the report to edit and clickOk.
The Edit Report ... window opens. The properties you can edit are the same ones used to create
the custom report.

Deleting a custom report

You may delete custom reports. You may not delete the default reports.

Step 1.
Step 2.

Step 3.

Step 4.

110

Navigate to the report table in the system’s menu structure.

Click on the Manage Reports button ([ ).
The Manage Reports window opens.

Click the Delete followed by clicking Ok.
The Delete Report window opens. This window lists all appropriate custom report options.

Choose the report to delete and click Ok.
The system deletes the report.
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Creating an email schedule for reports

To send email reports at designated times you need to have an appropriately configured schedule. Report
emails are initiated by a schedule that transitions from a false to true output. The following example
illustrates how you might create an appropriate schedule using the Create Schedule view, Special Events tab.
The procedure describes how to create a new schedule. You could also edit an existing schedule to create an
appropriate schedule for emailing.

Prerequisites:
You have set up custom schedule options and opened the Add New Schedule view opens.

Step 1. Type a name in the Display Name property and click the Save button.
The Summary tab opens with the name you just created as the view name.

Step 2. Select the Special Events tab and click the Add button (| & ).
The Add window opens.

Step 3. Type a name to identify when to send the email in the Display Name property, choose an
appropriate option from the Type option list and click the Ok button.
The email event displays in the Special Events table. Each event Type option provides different
configuration possibilities. For example, to send a one-time email report on a specific date,
choose the Date option. To send a report at the same time every week, choose the Week and Day
option.

Step 4. Select the newly added event, assign the Output property to true on a 15 minute block of time in
the Events editor (drag on the timeline or use the Start and Finish properties), and click the
Save button.
The system creates the new schedule and makes it available for assigning to an email report.

Step 5. Since you need the event to transition the schedule output value from a false to true output,
check on the Schedule Setuptab to make sure that the current schedule Output value is false and
that the Default Output value is set to false.

Assigning a schedule to a report

This procedure describes how to designate that a report be attached to an email that is sent at a scheduled
time.

Prerequisites:
This procedure requires:

* The report to email must be defined (default reports already exist, custom reports must be defined) so that
it appears as an option in the Schedule Emailed Report window.

* The schedule must exist so that it appears as an option in the Export Schedule property of the Schedule
Emailed Report window.

* A functional and accessible email account must exist so that it appears in the Email Account option list of
the Schedule Emailed Report window.

Step 1. Navigate to the report table and click on the Manage Reports button (| ).
The Manage Reports window opens.

Step 2. Choose the Schedule Emailed Report option and click the Ok button.
The Schedule Emailed Report window opens. This window displays a list of reports from which to
choose.

Step 3. Select the report and click Ok.
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The Schedule Emailed Report window opens.

Schedule Emailed Report: Schedules

Title |schedules x ]
File Type |POF |
Username |admin
Export Schedule  [lone »
Email Account
s |
|
Ce: |
o |
Email Subject: |
< »

Step 4. Click the browse icon (>>) next to the Export Schedule property.
The Ref Chooser window opens.

Step 5. Select the schedule in the table listing and click Ok or the || button to assign the schedule to
the report.
The Schedule Emailed Report window opens again.

NOTE: The system sends scheduled reports based on a schedule transition from a falseto a
true output state. This means that if the schedule you are using is already in a true output state
when you assign the schedule to the report, the system does not send the report. The assigned
schedule output must transition to false and then to true for the report to be sent.

Step 6. Select the email account from the drop-down list.
Step 7. Complete the rest of the email properties as appropriate, and click Ok.

Step 8. Use the large text field area to include a message in the body of the email.
The Schedule Emailed Report window opens again.

Step 9. At a minimum, give the report a Title, File Type, Alignment, and Style and click the Ok
button.
The report is now scheduled for delivery via email.

Printing a report
To print a report you first create a PDF and then print the PDF. Creating a PDF is an export function.

Step 1. Open the view that contains the records to export.

Step 2. Optionally, filter the table so that only the records to export are visible.
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Step 3. Click the Export button ([[]).
The Export window opens.

Step 4. Select an Export Range and click Ok.
The system opens a file chooser window.

Step 5. Define a PDF file name and click Ok.
Step 6. Open the PDF and print it.

Purging history records from a remote controller
History records can build up quickly in remote controllers, which have limited storage. Based on your audit
requirements, you can configure in advance each station’s purge policy.

Prerequisites:
You are connected to the remote station.

Step 1. Click Reports and click a history report.
The report view opens

Step 2. Click the Purge Config button (| /).
The Purge Config window opens.

Step 3. Configure the number of history records to retain, what should happen when the history file
reaches capacity, and click Ok.
The default, Rol1, replaces the oldest records with newer ones. Stop ceases recording when the
system reaches Capacity.

Purging history records from a Supervisor station

While a Supervisor PC has more room to store history records, you can configure when records expire and set
up an automatic purge schedule, or purge on a specific date.

Step 1. Click Reports and click a history report.
The report view opens.

Step 2. Open a history view.

Step 3. Click the Purge Config button (| #|).
The Purge Config window opens.

Step 4. Configure the data expiration date.
This identifies records that may be automatically deleted.

Step 5. Configure the Auto Purge date and time.
This tells the system when to automatically remove expired records. In lieu of this method, Manual
specifics a specific date and time (trigger) to purge the file of expired records.

Opening an exported CSV file in Microsoft® Excel®

When exporting a CSV file, long credential numbers may display in scientific notation. You can edit the CSV file
in Notepad or similar text editor and avoid this problem, or you can import the CSV file into Microsoft®
Excel®.

Prerequisites:

NOTE: The following procedure uses menus, window text, and options from Microsoft® Office Excel 2003.
Other versions of Excel may have different text and interface labels.

Step 1. Open a blank worksheet in Excel.
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Click in the Al cell to designate a cell location for import.
From the Data menu, select Import

Browse to the location of the CSV file, select it, and click the Open button.
The import wizard, step 1 opens.

Click the Next button.
The import wizard, step 2 opens.

In the Delimiters area, click to clear the Tab check box, select the Comma check box, and click the
Next button.
The import wizard, step 3 opens.

Under the Data preview area, click to select the Credential Number column (or the column that
contains the data that is being converted incorrectly).

Under the Column data format area, select the Text option and click the Finish button.
The Import Data window opens (some versions) asking where to put the data.

. With the $A$1 field selected, click OK to complete the import.
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Chapter 7. Station save, backup and
restore

To keep a system healthy, periodic station saves and backups are required.

The normal controller station save captures changes to the station’s object spaces (components, alarm, history)
to flash memory.

A backup automatically performs a local station save first, and then, running as a standard station job, backs up
all station data to the Supervisor station. This creates a .dist file, which can be later restored following a
software upgrade or installation of a new controller.

Restoring a station from a backup .dist file returns the station to the state it was in when the backup job ran.

About station save

A single file defines a station database: file:~stations/{name}/config.bog. This bog (Baja object
graph) file contains the collection of station components in an HSQL relational database management system.
This database offers a fast response time in an embedded environment.

The config.bog is required to boot a station and manage its components. A station save differs from a local or
system backup in that a station save backs up the config.bog to a local destination. A local or system backup
saves the data collected by the system to the Supervisor PC.

Data storage in a controller is limited compared to the storage available on a PC. Each time you save a
controller station, the system makes a copy of the config.bog in the controller's memory. The save station job
can also compress the HSQL database to remove empty space (requiring less memory and improving
performance). This de-fragmenting of the database requires time, and may or may not be needed depending
on how you use the system. You can enable and disable de-fragmentation as part of a station save. You can
also manually initiate a station save with de-fragmentation.

Saving a station

A station save captures all changes to the station’s object spaces (components, alarm, history) to flash memory,
saved as the files config.bog, alarm.zip and history.zip. You should save a station before upgrading and on
other occasions.

Prerequisites:
You are working in the web UL.

Step 1. Navigate to Controller Setup > Miscellaneous > Configure Database and click the HsqglDatabase
tab.
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Step 2. Confirm that Defrag On Save is set based on your requirements.

The property sheet view opens.

£ Home | | &2 Monitaring [ & Personnal Reports &% Controller Satug

B Schedules & UserManagement 0= Backups  #F Remoie Devices ¥

Database Services  HsglDatabase

Status {ak)

Enabled true

Fault Causa

Health Ok [05-Sap-18 7:32 PM IST]
Alarm Source Info Alarm Source Info »

User Name 53

Password --passward-—

Base Directory filer~~hsgldb

Database Name  orion
Defrag On Save e *

Niagara Enterprise Security Facility Manager's Guide

Selecting true configures the system to empty space and compress (de-fragment) the database
during the save station job. In a controller station, and depending on the volatility of your

database, this de-fragmentation step could take a significant amount of time.

Selecting false configures the system to ignore empty space in the database, and just save the
database as it is. This is the quicker option, however, and, again, depending on your database,

you should regularly schedule a station save with de-fragmentation.

Step 3. Navigate to Miscellaneous > Controller Maintenance.
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The Maintenance view opens.

= Save || A Save Stabon
Maintenance Info
Software Version
Entsec Version
Access Driver Version
Last Station Restart
Last Station Save
Intrusion Detection
Threat Level Group Limit
Threat Level Count Limit
Reader Limit
Reader Count
Elevator Limit
Elevator Count
ADA
Access Jone Limit
Access Zone Count
Credential Limit

L

f£8 Home | | 6 Monitaring | | &g Personnel Reports

B Schedules & User Management

k& Defrag And Save Station

Station save, backup and restore

A% Controller Satup

i= Backups #F Remote Devices &% A

Get Invalid Pins

[2.4.27
l4.6.3
k6.3

|37mins ago

iE-Brnins ago
|Licensed
[unlimized

B

¥
[1e
2

:Unllmrbad

o
Licensed
[onlimited
o
| ey
il.,lnlll\'ntad

Step 4. Do one of the following:

e Click
Save Station

. If Defrag On Save is set to true, the system de-fragments the database as part of the
save job. If it is set to false, the job proceeds more quickly because no de-fragmentation

takes place.

* Click Defrag And Save Station. If the HSQL database is configured for Defrag On Save set
to false, this button overrides the false setting and de-fragments the database along with

the save job.

Result

You can also configure Defrag on Save in Workbench (expand Drivers > RdbmsNetwork > HsqlDatabase and

view the property sheet.

Data backup

System backups are an important part of a disaster recovery plan. Software backups should be done at an
interval that matches the dynamic nature of a system.

For example, if a system has just a few database changes a month and history file retention is not critical,
monthly backups may be sufficient. In a very dynamic system, where database retention is critical, backups may

need to be done on a daily basis.

Three backup operations are available:

* A system backup combines a Supervisor station and one or more subordinate stations in a single backup
job. System backups create *.zip files. To restore a system backup you must first un-zip the file using a third-
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party data compression utility.

* A local backup creates a single compressed distribution file (*.dist) of a Supervisor or controller station. The
restore job requires only the .dist file.

* You can use a station copy to back up all files and subdirectories.

After creating the backup, you should download it, copy it to a thumb drive or other storage medium, and
store it off site in a secure location.

Software backups need to be stored at a secure location that is isolated from the system. When choosing how
and where to store a backup, remember that system backups contain information that could be used to
compromise the security of a system or network. You may send the backup to the local server drive or a
mapped network drive. For disaster recovery purposes, it is recommended that the backup either be sent to a
network drive at another physical location, or that auto archiving of the server be setup to archive to a remote
server.

Backing up a local station

This procedure backs up the station you are currently logged into. This may be the Supervisor station or a
remote controller station. The file created using this procedure is a compressed distribution (.dist) file.

Prerequisites:
Workbench is available on a PC connected to the network.

Step 1. Using Workbench, determine what to exclude from the backup by editing the property sheet of
the BackupService.
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Property Sheet

@) BackupService (Backup Service)
(@ status

(@l Fault Cause
(@l Enabled
(@ Exclude Files

(@l Exclude Directories

(M Offline Exclude Files

(M Offline Exclude Directories

{ok}

. true

* hdb;*.adb;¥.lock; console.*;config.bog.l

file:*history @ 4
file:italarm
filestemp

¥.lock:;console.*;config.bog.b*;config bas

file:rtemp ® X

D Refresh Save

The default settings do not back up the history files or alarm database. Access history is stored in
the rdbms database so, unless you have critical trends running, there may be no need to back up
the history files. The local backup files are also excluded from this backup because including
previous backups in a backup file does not make logical sense and causes the backup file size to
grow exponentially.

Step 2. Do one of the following to make a distribution file backup of the existing controller station:

* If you are in Workbench, select the station in the Nav tree, right-click and click Backup

Station.
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I;:9 3 G} My Metwork

@ My Haost : IEGTOTGODOGDZ. global.ds. haneywell.com (e
@) My File System
0 My Modules
;P My Tools
& Platform
& station (entSecurity) RTRTE
172.31.66.10 (entSecurity]
172.31.66.11
199.63.106.201 Disconnect
IEGTLTFXRFE22.zlohal.ds. JIRSEEE

platddmin

Refresh Tree Node

Go Into

* To use the web UI, click Controller (System) Setup > Backups.

| save | @& System Backup | @ Local Backup | €3 Restore

Backup Archive Backup Schedule Recent Backup History

@@ o
File Name Timestamp

Backup Type Size

14 file:~backups/backup_entsec_180807_1910.zip  07-Aug-18 7:10 PM IST  System

iliﬁ file:~backups/backup_entsec_180710_1516.zip 10-Jul-18 3:16 PM IST

Step 3. Continuing with the Web UlI, click the Local Backup button.
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Step 4.

Step 5.
Step 6.

Step 7.

Step 8.

A Local Backup window opens.

Local Backup

! Archive Backup on Supervisor
| Download Backup

[k [ conel

The first option saves the file in the backups folder under the Supervisor station. The second
option automatically downloads the backup to the computer’s Downloads folder.

To continue, click Ok.
The Job window displays a progress bar while the backup job runs. When the job is finished, the
Local Backup window opens.

Local Backup

€D Success
Show Details

Click the Show Details link to open a window that displays the history of this backup job.

To save the backup *.dist file to a designated location, click the Download button.
The browser prompts you to open or save the file. You cannot save it to the controller.

NOTE: You must save the file within five minutes of creating it. If you view the file, it opens from a
temporary directory. You must designate a save-to location to save the file to a location other than
the temporary location.

Do one of the following:

¢ Choose to save the file.

* Choose to open the file.
If you chose to save the file, a browser prompts you to open the Downloads folder. If you chose to
open the file, you can save it from the opening application interface (this must be a file-
compression application).

Make a note of the date and where you saved any downloaded backup files so you can find them
later.

Backing up the station using station copier

This procedure is for replacing a current controller with a different model. To restore a station to a platform of
a different type than the original platform on which the station was running, requires a station copy rather than
the creation of a distribution file. This is because the distribution backup depends on platform files.

Prerequisites:
You need Workbench for this functionality. The web Ul does not support a station copy.

Step 1.
Step 2.

Connect a PC to the network and open Workbench.

To back up the station, expand the Platform node in the Nav tree and select the Station Copier.
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The transfer wizard opens.

My Host: IEGTDTGODOGD2.global.ds.honeywell.com (entSecurity) . Platform / Station Copier =

- Nav Station Copier
E@ C X @ My Networl e Stations on this computer & Stationson "localhost”

JC: /Users/H277129%9/Niagarad.&/t) O ~3tations

v (@ My Host:IEG7DTGODOGD2.glol
@ iy File system BACNET

9 My Modules EighteenJune

Ent11522018 i i " ity"
& My Tools n £~ Transferring station "Security
EnterpriseSecurity u What name would you like the new station to have?

4% Station Transfer Wizard

BT Platform

EntpriseSecurity Station name 5 =
@ Application Directar ECurity

EntSec_Supervisor

0 Certificate Managen entSecurity

9 Lexicon Installer entSecurity801
a License Manager Jace
o Platform Administra Rashmi
e Station Copier i
© Tcrip configuratia
b a Remaote File System
» & station (entSecurity)
172.31.66.10 (entSecurity801)
172.31.66.11

199.63.106.201 J/ Finish

IEGTLTFXRFG22.global.ds.hon

- Palette

Step 3. Select the option to copy every file in the station and its subdirectories and click Next.

Step 4. Use the File Transfer Client to copy the security folder from the controller to a backup location
(on your PC).
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Application Director

Connected to localhost

MName Type  Statuzs  Details Auto-Start Restarton
E entSecurity station Running fox=1911 foxs=4911 http=n/a,https=443 false true
E Security station Running fox=1911 foxs=4911 http=n/a,https=443 true true

SEV]

45 Transferring station

T ¥ k A -
W% not create socke [] Auto-Start

[#] Restarton Failure

‘,‘ J Transferring station Start
Stop |
Completing transfer: Restart |
€D Transferfiles Success Reboot
oﬂtartstatinnl:s] Success
Kill |
Transfer complete,
Dump Threads |
Transferring files...
Sending ~stations/Security/config.bog Save Bog |
FileStore::commit -
FileCachedFileStoreElement: :commit £ils Verify Software |
FileStore::commitInstance commit compls
Station "Security™ starting.
Clear Dutput |

Transfer complete.

Pausze Output |

Output Dialog |

Close Stream To File |

Output Settings |

Station save, backup and restore

CAUTION: Do not overwrite the security folder in your Workbench. This folder contains
encryption keys, which you will need in the new controller to decrypt user passwords.

Creating a system backup

Performing an ad hoc backup of a Supervisor station may be required if you are updating the station software
or installing a new feature. System backups are available only for Supervisor stations. The system backup file
contains backup files for the Supervisor station and all subordinate stations. A Local Backup backs up only the

Supervisor station. The file created using this procedure is a compressed (.zip) file.

Prerequisites:
You are working in a Supervisor station.

Step 1. From the Supervisor system main menu, select System Setup > Backups.

The Backups view opens.

Step 2. Click the System Backup button.

A System Backup window opens. The first option saves the file in the backups folder under the
Supervisor station. The second option automatically downloads the backup to the computer’s

Downloads folder.
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Step 3.

Step 4.

Step 5.
Step 6.

Step 7.

To create the system backup, click Ok.

The Job window displays a progress bar while the backup job runs. When the job is finished, the
System Backup window reports success or failure. Clicking the Show Details link opens a window
that displays the history of this backup job.

To save the backup *. zip file to a designated location, click the Download button.

The browser prompts you to open or save the file.

NOTE: You must save the file within five minutes of creating it.

If you choose to open the file instead of having the browser save it, you can save it from the
opening application interface (this must be a file-compression application).

If you chose to save the file, the browser prompts you to open the Downloads folder.

Click to open the folder and copy or cut and paste the file to a different location on the
Supervisor's hard disk or thumb drive.

Should you need to restore the backup later, make a note of the date and where the file is
located.

Creating a backup schedule for a system backup

Regularly backing up a Supervisor station consistently preserves data collected from all the remote controllers
joined to the Supervisor. This is the recommended method to back up the system.

Prerequisites:
You are working in the Supervisor station. You chose a time when the system is least busy. The backup service
may slow down system response.

Step 1.
Step 2.

Step 3.

124

Determine the frequency and time you want to backup the system.

From the main menu, select the following: System Setup > Backups, and click the Backup
Schedule tab.
The Backup Schedule tab opens.

Backup Archive Backup Schedule Recent Backup History

System Backup Schedule Mone »
Local Backup Schedule Mone »
Scheduled System Backup Limit [1 - +inf]
Scheduled Local Backup Limit [1- +inf]

Alarm Info Alarm Source Info »

Click System Setup > Schedules, add a new schedule and click Save.
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The schedule view opens.

&d” Monitoring .ﬁ Personnel & System Setup [ Photo ID

B schedules A, User Management [%* Backups #¥ Remote Devices & Access Setup &

| Save || ) Schedules

Summary Scheduler Schedule Setup Special Events  Access Rights  Intrusion Pins
@|m| T &) D

Sun Mon Tue Wed Thu Fri Sat

Start: (01 v[:[30 v||am v|1sT
Finish: 103 v |00 v||am v|1ST
Output: L1 null

The Default Output for this Schedule is currently set to "Denied {ok}".

The example shows a backup occurring every Sunday morning at 2 AM.

Step 4. Click System Setup > Backups, and click the Backup Schedule tab.
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The Backup Schedule tab opens.

Save | & System Backup = Local Backup | €@ Restore

Backup Archive Backup Schedule Recent Backup History

System Backup Schedule Mone w
Local Backup Schedule Mone »
Scheduled System Backup Limit [1 - +inf]
Scheduled Local Backup Limit [1 - +inf]

Alarm Info Alarm Source Info »

There are two backup schedules: system backup and local backup. The system backup backs up
the server station and all subordinate stations, while the local backup only backs up the server
station. You may want to schedule the local backup to occur more frequently than the system
backup.

Step 5. Assign the schedule to the backup job, and click Save.
When the backup job runs, the system saves the backup as a zip file that contains the distribution
files for the Supervisor and all its subordinate controllers.

MySQL and MS SQL Database backups

The system is contained in an RDBMS Relational Database Management System). This database contains all
personnel, access right, credentials, access history, and other access information. The system supports a
variety of databases: MySQL or MSSQL, HSQL, Orion.

Figure 20. MySQL database in the Workbench Nav tree

= E Qrion

- B MysQLDatabase

- (7] orion
+ [ orion&ppversion
- [ Sriondudit

The backup does not include a MySQL database. You must make provisions to have this database backed up
separately either using database tools, or system recovery backups.

If this database is lost, you can pull most of this information back up from the controllers, but any information
programmed at the Supervisor level is lost.

Data restore

The Recent Backup History tab contains a table of all backups jobs that are run, even if the resultant backup
file is not saved or downloaded to a designated location. This means that it is possible to see a file name listed
in the Recent Backup History that is unavailable for restoring.

Due to stored dependencies, a distribution backup can only be restored to a like platform. To restore a station
to a different platform model, rename the distribution backup to a zip file, extract the contents, and use the
station copier to copy the station out of the backup without the rest of the information.
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Viewing backup history

Before restoring a data backup, this procedure documents how to view the list of backups that have been
made.

Step 1. From the main menu, select System (Controller) Setup > Backups.
The Backups view opens.

Step 2. Click the Recent Backup History tab.

Save || & System Backup || = Local Backup | €3 Restore

Backup Archive Backup Schedule Recent Backup History

AP
¥
08-Aug-18 2:42 PM IST IEG7DTGODOGD2. global.ds.honeywell.com archive/hx:backup_entSecurity_180808_1442.dist admin
07-Aug-18 7:10 PM IST IE67DTGODOGD2. global.ds.honeywell.com archive/hx:backup_entsec_180807_1910.zip admin
10-Jul-18 3:16 PM IST IEA7DTGODOGD2. global.ds.honeywell.com archive/hx:backup_entsec_180710_1516.zip admin

This tab lists all backup jobs.

NOTE: If the backup file was not saved or downloaded to a designated location, its file name may
be listed in this table, but it may not be available to restore.

Restoring station(s) using the Web Ul

You may need to restore a system or a local station. A system restore restores a Supervisor station and one or
more subordinate stations in a single backup job. System backups are saved as *.zip files so you need to find
the proper *.zip file to initiate a system restore. A local restore restores a single Supervisor or controller
station. Local backups are saved as *.dist files, so you need to find the proper *.dist file to initiate a local
restore.

Step 1. From the main menu, select System (Controller) Setup > Backups
The Backups view opens.

Step 2. Click the Restore button.
The Restore from Backup Distribution File view opens.

Step 3. Click the Browse button.
The File Upload window opens.

Step 4. To initiate the restoration job, navigate to and select the file (*.zip for a system restore or *.dist for
a local restore) and click the Save button.
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NOTE: The Recent Backup History tab contains a table of all backup jobs that are run, even if the
resultant backup file is not saved or downloaded to a designated location. This means that it is
possible to see a file name listed in the Recent Backup History that is unavailable for restoring.

The Restore window opens to let you select and confirm the station(s) that you want to restore.

Yhich station{s) would you like to restore?

Restore station "entSecurity™ to host "¥YAS51DT3I400MM™.

| ok || cancel |

Step 5. Confirm the identification of all selected stations and hosts.
CAUTION: Restoring the wrong station makes right station temporarily unavailable. Remember,
the station is restored to its state at the time of the backup.

Step 6. To begin the restoration, click the Ok button.
A message prompts you to confirm the action.

Step 7. To confirm, click Ok.
The Restore from Backup Distribution File window displays a progress bar. When the job has
finished, the System Restore window displays a message to let you know if the restoration
succeeded or failed.

Step 8. If the restoration was successful, click the Ok button to close the System Restore window.
If the restoration failed, lick the View Details link to help diagnose the problem.
The system restarts a restored station. This causes a temporary loss of communication.

NOTE: Restart takes several minutes. After a station restart, type in the login URL in the browser
(a browser Refresh may not create a new station connection).

Troubleshooting

This topic identifies and documents some technical issues, error messages and provides an explanation.
While configuring a time range | got the message, “Advanced Filtering too Strict.”

You have configured an illogical database inquiry. For example, you selected a specific date using a filter, then
in the Advanced Time Range Options window you excluded a day of the week that corresponds to your
selected date.

Change the filter or the options.

* There is no capture button/icon on my Person view. The capture icon (&) requires a native badge
designs device. If you see no capture button, your system has not been configured yet for the Photo ID
feature.

* | cannot find the window | am expecting to see. Temporarily minimize your browser or other windows to
see if the window is behind.

* | cannot upload a photo to the database. For you to upload a photo, the person must already exist in the
database. Create and save the person, and then the upload icon will be available.

Badge creation troubleshooting

This topic identifies some technical issues and provides an explanation.
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¢ There is no capture button/icon on my Person view. The capture icon (G) requires a native badge design
device is added under the photo ID network be added to the station. If you see no capture button, your
system has not been configured yet for the Photo ID feature.

| can't find the window I'm expecting to see. Temporarily minimize your browser or other windows to see
if the window is behind.

| cannot upload a photo to the database. For you to upload a photo, the person must already exist in the
database. Create and save the person, and then the upload icon will be available.
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